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C H A P T E R  8

Getting Everything Up 
and Running

This chapter guides you through setting up all the essential components of your Ubuntu 

installation. This includes hardware configuration, as well as setting up e-mail. It covers 

the postinstallation steps necessary to get your system up and running efficiently.

Like all modern Linux distributions, Ubuntu is practically automated when it comes to 

setting up key hardware and software components. Key software will work from the start, 

and most hardware will be automatically configured. However, you might need to tweak 

a few settings to make everything work correctly. Read on to learn more.

Ubuntu Hardware Support
The age-old criticism that the Linux operating system lags behind Windows in terms of 

hardware support is long dead. The majority of add-ins, such as digital cameras and 

printers, will all work with Ubuntu immediately, with little, if any, configuration.

In fact, most underlying PC hardware is preconfigured during installation without your 

knowledge and without requiring further work. Both your graphics and sound cards 

should work without a hitch, for example. In addition, nearly all USB and FireWire devices 

you plug in after installation will be supported.

Ubuntu doesn’t support a few hardware items. Generally, it’s a black or white situation: 

Ubuntu either works with a piece of hardware or it doesn’t. 

The types of hardware that Ubuntu doesn’t support tend to be esoteric devices that rely 

on custom software provided by the hardware manufacturer. It’s also sometimes the case 

that brand-new models of hardware won’t work with Ubuntu because support has yet to 

be added. However, as soon as a new piece of hardware comes out, work is usually under-

taken to ensure that Linux is made compatible with it. This is especially true of hardware 

such as printers and scanners, and it’s one more reason why you should regularly update 

your system online, as explained in Chapter 9.
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■Tip  Before you buy a new piece of hardware, why not ask the salesperson if it runs under Linux? You can 

only hope that the salesperson knows or can find out for you. Also, compatibility with Linux is often listed on 

the hardware box or at the manufacturer’s web site (even if you sometimes need to search through the FAQ 

section to find out about it!).

Unfortunately, unlike with Windows, it’s rare to find Linux drivers on the CD that comes 

with the hardware. Even if you do find a Linux driver supplied, chances are that it will 

work with only certain versions of Linux, such as Red Hat or SUSE Linux. There are also 

some drivers that are usable but imperfect or lack features that are available in their 

Windows counterparts. At the time of this writing, Ubuntu has yet to gain the kind of 

momentum where manufacturers specifically produce drivers for it, but this may change 

in the future. At least Dell, Everex, Asus, and Shuttle are now bundling Linux with their 

product offerings. Other OEMs may soon follow suit.

■Note  It’s possible to use a program called alien to convert software installation packages designed for 

other distributions into Ubuntu installation files. Doing so isn’t very complicated but may not work very well 

with driver files because of the subtle differences in where system files are stored across different Linux 

distributions. You can find more information about alien at http://kitenet.net/~joey/code/alien/. 

It’s contained within the Ubuntu software repositories and can be downloaded using the Synaptic Package 

Manager, as explained Chapter 28. 

Proprietary vs. Open-Source Drivers

As discussed earlier in this book, Linux is an open-source operating system. This means 

that the source code underlying Linux programs is available for study and even reuse. This 

is a good thing when it comes to hardware drivers, because bugs in the code can be spotted 

and repaired by anyone with an interest in doing so. If you consider that a bug in a graphics 

driver could mean your PC crashes every five minutes, the value of such an approach is 

abundantly clear.

Unfortunately, some hardware manufacturers don’t like to disclose how their hard-

ware works, because they want to protect their trade secrets. This makes it impossible for 

them to release open-source drivers, because such drivers would expose exactly how the 

hardware operates. Because such companies are aware of the fact that growing numbers 

of people use Linux, they release proprietary drivers, whose source code is not made 

publicly available.

Aside from ethical issues surrounding not being able to study the source code, the 

biggest issue with proprietary drivers relates to bug fixing. To use a proprietary driver is to 
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be at the mercy of the hardware manufacturer’s own development and release schedule. 

If the driver has a serious bug, you’ll either have to work around it or put up with troubling 

issues until the manufacturer offers an update. A few years ago, a proprietary driver for a 

3D graphics card stopped any computer it was installed on from going into hibernation 

mode (that is, suspending to disk). Those using the drivers had to wait months until the fix 

was released.

Despite this and although the folks behind Ubuntu strongly support open-source soft-

ware, they realize proprietary drivers need to be used in certain situations. For example, 

it’s impossible to use the 3D graphics elements of some graphics cards unless you have a 

proprietary driver, and this means that desktop visual effects will be unavailable to users 

who happen to have hardware that isn’t currently fully supported by open-source drivers.

 Because of this, Ubuntu automatically installs Wi-Fi proprietary drivers by default if no 

open-source alternative exists (or if the open-source version is not yet good enough). It 

also offers the opportunity to easily install some proprietary graphics card drivers if they 

provide more functionality than the open-source versions.

■Note  Linux sees hardware in a technical way, rather than in the way humans do. If you attach something 

like a USB CD-R/RW drive, Linux will recognize the drive hardware and attempt to make it work. It won’t try 

to find a driver for that specific make and model of CD-R/RW drive. Thus, Linux is able to work with a wide 

range of hardware, because a lot of hardware is actually very similar on a technical level, despite the differ-

ences in case design, model names, and even prices!

WHAT HARDWARE WORKS?

The question of what hardware works under Ubuntu is one that’s not easily answered. However, you can 

take a look at http://wiki.ubuntu.com/HardwareSupport to see if your hardware is listed. This 

is an informal list created by the Ubuntu community, and it’s not comprehensive (which is to say that 

there may be hardware that works fine that isn’t mentioned). Nor is the list guaranteed to be 100% accurate. 

But it’s certainly worth a look.

A search engine like Google is your best friend if the Ubuntu hardware list doesn’t help. Simply 

search for the brand and model of your hardware and add “Ubuntu” to the search string. This should 

return results, usually from the Ubuntu forums (http://ubuntuforums.org) or blogs, written by 

those who have found a way to make that type of hardware work.

Installing Device Manager

When using Windows, you might have come across Device Manager, the handy tool that 

lists your PC’s hardware. Ubuntu offers a similar piece of software, as shown in Figure 8-1, 

but it isn’t installed by default. 
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Figure 8-1. Ubuntu’s Device Manager program can display just about everything you need to 

know about attached hardware.

After you can connect to the Internet (following the instructions in the “Getting 

Online” section of this chapter), you can install Device Manager using the Synaptic 

Package Manager (see the “Installing Software” section of this chapter), as follows:

1. Select System ➤ Administration ➤ Synaptic Package Manager.

2. Click the Search button on the toolbar, and then type gnome-device-manager in the 

Search field. Click the Search button.

3. Click the program’s entry in the list of results. Select to mark it for installation (don’t 

worry if a dialog box appears telling you additional software needs to be installed).

4. Click Apply on the toolbar. 

If your computer is not yet online, you’ll need to use a computer that is online (perhaps 

another computer, or Windows XP if you dual-boot) to download the software, and then 

copy it across to your Ubuntu computer for installation. To download the software, visit 

the following two addresses in your browser. You will be prompted to download a file after 

typing each address:



C H AP T E R  8  ■  G E T T I N G  E V E R Y T HI N G  U P  A N D  R U N N IN G 121

http://us.archive.ubuntu.com/ubuntu/pool/universe/g/gnome-device-manager/

gnome-device-manager_0.2-1_i386.deb

http://us.archive.ubuntu.com/ubuntu/pool/universe/g/gnome-device-manager/

libgnome-device-manager0_0.2-1_i386.deb

After the files are downloaded, copy them to the desktop on your Ubuntu machine, 

using a floppy disk or maybe a USB memory stick. Then open a command-prompt window 

on the Ubuntu computer by clicking Applications ➤ Accessories ➤ Terminal. In the 

terminal window, type the following, hitting Enter after each line:

cd ~/Desktop

sudo dpkg –i libgnome-device-manager0_0.2-1_i386.deb

sudo dpkg –i gnome-device-manager_0.2-1_i386.deb

After you’ve installed Device Manager, you can open it by selecting Applications ➤ 

System Tools ➤ Device Manager. You’ll need to click View ➤ Device Properties to ensure 

Device Manager adds the useful Properties tab. 

You should be aware of a few important differences between the Windows and Ubuntu 

versions of Device Manager. Though the aim of Ubuntu’s Device Manager is to manage 

hardware devices, the project is still in its infancy and can only provide hardware informa-

tion as of the time of writing. On the other hand, Ubuntu’s list is far more comprehensive 

than that in Windows. In Ubuntu, Device Manager thoroughly probes the hardware to 

discover its capabilities.

Perhaps the biggest difference, however, is that just because a piece of hardware is 

listed within Ubuntu’s Device Manager, it doesn’t mean that the hardware is configured 

to work with Ubuntu. In fact, it doesn’t even imply that the hardware will ever work under 

Ubuntu. Device Manager’s list is simply the result of probing devices attached to the 

various system buses (PCI, AGP, USB, and so on) and reporting the data.

Nonetheless, Device Manager is the best starting place if you find that a certain piece 

of hardware isn’t working. If a piece of hardware is listed, then it proves, if nothing else, 

that the system recognizes that the hardware is attached. For example, later in this chapter, 

I’ll describe how you can use Device Manager to discover crucial details about wireless 

network devices, which we will then use to install drivers.

How to Configure Ubuntu
Unlike some versions of Linux, Ubuntu doesn’t rely on a centralized configuration soft-

ware package. Instead it uses smaller programs to configure hardware. For example, to 

configure the network, you’ll use the NetworkManager program, and printers are configured 

using a separate printer configuration program. Because using some of the configuration 

software involves reconfiguring your entire system, doing so requires administrator priv-

ileges. Therefore, you’ll be prompted for your login password each time you use some of 
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the programs. In some cases, after you’ve made changes, you’ll need to click the Apply 

button to put the changes into effect. When you’ve finished configuration, simply close 

the program window by clicking the Close button. 

■Note  For five minutes after you enter your password, Ubuntu remembers it, so if you open the same appli-

cation or another that requires administrator privileges within that amount of time, you won’t be prompted. 

Along with the individual configuration programs, you may also need to use the command 

line and install software to get your system up and running. We’ll take a quick look at how 

you can do both, before proceeding with the instructions for getting online.

Using the Command Line

For some configuration steps, we will ask you to open a terminal window. This will give 

you access to the command-line prompt, by which you can issue commands directly to 

Ubuntu. The Linux command-line prompt is a little like MS-DOS, which you might have 

used in the early days of Windows, except it’s a lot more powerful. As with DOS, you should 

press Enter after typing each command. Nearly all the commands affect your system, so 

they will require you to enter your password when prompted. 

We explain all about the command-line prompt in Part 4 of this book, beginning with 

Chapter 13, but for the moment, you should bear in mind the following points:

• Check the command once you’ve typed it to ensure it reads as is printed on the 

page. Even a stray space in the command could cause havoc.

• Don’t be tempted to experiment at the prompt at this stage of your Linux learning 

curve. This is especially true should you use administrator powers, which you’ll be 

doing for nearly all the commands. 

To open a terminal window, click Applications ➤ Accessories ➤ Terminal. After you’ve 

finished entering the commands and they have completed, simply close the program 

window. 

Installing Software

Throughout this chapter and in other chapters in this book, we might ask that you install 

software packages using Ubuntu’s software configuration tool, the Synaptic Package 

Manager. Some software packages might be installed from the DVD-ROM disc, so you’ll 

need to keep that handy, but the majority will be automatically downloaded from online 

repositories once you’ve configured your computer to go online. 
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We explain all about software installation in Chapter 28 of this book, but here’s a brief 

primer on what to do: 

• To open the Synaptic Package Manager, click System ➤ Administration ➤ Synaptic 

Package Manager. Because you’re reconfiguring your system, you’ll need to enter 

your login password when prompted. 

• Every time you use the Synaptic Package Manager, you should click the Reload 

button, at the left side of the toolbar running across the top of the screen. This will 

grab the most up-to-date list of software from the online servers. 

• To search for software, click the Search button on the toolbar, and type the name 

into the Search field of the dialog box. Then click the dialog box’s Search button. 

• To install a software package, click the check box alongside it in the list of results, 

and click Mark for Installation on the menu that pops up. Sometimes you might be 

informed that extra software packages need to be installed. This is fine, and they will 

automatically be added to the list. 

• When you’ve finished making your choices, click the Apply button on the main toolbar. 

Click Apply once more in the dialog box that appears to confirm your choices.

• When installation has finished, click the Close button in the dialog box, and close 

the Synaptic Package Manager. 

GETTING HELP FROM THE COMMUNITY

Configuring hardware is one area where the value of the Ubuntu community becomes very apparent. If 

you run into a problem, it’s unlikely your situation will be unique. Others will probably have encountered 

the same problem and may have figured out a solution. If so, they may have posted it online. If nothing 

else, you might find sufficient clues to be able to solve the problem by yourself. Sharing information in 

this way is part of the spirit of Ubuntu and also Linux. 

We’ve tried to provide complete guides to most hardware configuration in this chapter, but if you 

run into problems, your first port of call should be the Ubuntu forums, at www.ubuntuforums.org. This 

is the central meeting place for the Ubuntu community. You can search through existing forum postings 

or start your own thread asking for help. We explain a little more about the protocols of asking for help 

in Appendix C of this book. 

Also worth visiting in times of trouble is the community-written wiki, which can be found at 

https://help.ubuntu.com/community. Here, you’ll find a range of guides to help configure various 

aspects of Ubuntu. A wiki is a form of web site that anyone can edit or contribute to. The idea is that it’s 

constructed by its readers. 
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We also recommend taking a look at the Ubuntu Guide, at http://ubuntuguide.org, which is 

also community-written. The Ubuntu Guide can be very concise, and often expects a relatively high 

degree of technical knowledge, but it is also very comprehensive. 

Finally, don’t forget that you’re a member of the community, too. If you encounter and subsequently 

solve a configuration problem, share the solution with others. You can do this by editing the Ubuntu wiki 

or posting to the forums.

Getting Online
Getting online is vital in our modern Internet age, and Ubuntu caters to all the standard 

ways of doing so. Linux was built from the ground up to be an online operating system 

and is based on Unix, which pioneered the concept of networking computers together to 

share data back in the 1970s. However, none of this is to say that getting online with Ubuntu 

is difficult! In fact, it’s very easy.

Regardless of whether you use a modem, standard Ethernet network device, or wireless 

network device, the same program, NetworkManager, is used to configure your network 

settings under Ubuntu. Support for many makes and models of equipment is built in, so 

in most cases, all you need to do is enter a few configuration details.

■Note  Linux actually runs around 60% of the computers that make the Internet work! Whenever you visit 

a web site, there’s a strong chance that it’s run using Linux. As your Linux skills increase, you’ll eventually get 

to a stage where you, too, can run your own Internet servers. It sounds difficult, but can be quite easy.

Using NetworkManager

NetworkManager lets users easily manage both wireless (also known as Wi-Fi) and wired 

connections, such as Ethernet connections. It sits in the notification area at the top right 

of the desktop (look for the icon of two screens inset against each other) and automatically 

detects any wireless networks that are in range, as well as if you’re currently plugged into 

a wired network.

Clicking the NetworkManager icon will show a list of networks that have been detected. By 

selecting the entry in the list, you can then connect to the network, and you’ll be prompted 

to configure WEP/WPA protection, if applicable.
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■Caution  On our test system, which attempted to connect to a 3Com ADSL Wireless 11g Firewall Router, 

we were prompted for the wrong kind of wireless protection (we were asked for a 128-bit WEP key rather than 

a 64-bit key). In other words, it pays to check that you’re being prompted for the right thing, and to select the 

correct option if you’re not. Failure to do so might result in frustration!

Following this, the NetworkManager icon will display the signal strength of the connection 

for as long as you’re connected. By clicking it, you’ll be able to see at a glance what network 

you’re connected to. If you want to switch networks, just click the NetworkManager icon 

and select a different network in the list. 

■Tip  By right-clicking the NetworkManager icon, you can opt to completely disable your network hardware 

if you wish. 

NetworkManager settings persist across reboots, provided the network that was last 

configured is in range. This means that NetworkManager is ideal for all kinds of wireless 

network users, from those who frequently switch between different networks (that is, 

mobile workers) to those who just use a single wireless network connection, such as that 

provided by a wireless network broadband router in a home/small office environment. 

NetworkManager will also let you switch to a wired (Ethernet) connection, if and when 

you attach one to your computer. 

NetworkManager works in two modes: roaming and manual. Roaming mode is the 

default and works as we’ve just described: NetworkManager will automatically detect 

networks and the type of connection. In manual mode, you can opt to manually supply 

details, such as the IP address and gateway, or the name of the wireless base station, 

which might be necessary if your base station doesn’t broadcast its name of if you need to 

connect to a specialized setup. However, for most users, roaming mode will suffice, and 

you won’t need to bother with manual mode. 

Configuring an Ethernet Network Device

Ethernet is one of the oldest and most established network technologies. When we talk 

of Ethernet, we refer to wired networks—all the computers on the network are connected 

by cabling to a central hub or router. (The other form of networking technology, which 

works without wires, is covered in the next section.)
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You might go online via Ethernet in a variety of situations. If you have DSL or cable 

broadband service at your home or workplace, for example, you might use a DSL router 

that has a number of Ethernet ports. Your computer will then connect to this router via an 

Ethernet cable.

If you’re running Ubuntu on a PC in an office environment, it’s likely that you will 

connect to the local area network using Ethernet. This lets your computer communicate 

with other computers, as well as with shared printers. In some offices in which an Internet 

connection is provided, this connection might also allow you to go online.

In most cases, NetworkManager’s roaming mode will sense a wired Ethernet connec-

tion and automatically connect using the Dynamic Host Control Protocol (DHCP). This 

means that your computer receives its IP address, gateway, subnet mask, and Domain 

Name System (DNS) addresses automatically. All routers manufactured today are set up 

to automatically use DHCP out of the box. 

■Tip  If a DHCP server is not available, Ubuntu will attempt to set up a network automatically using the Zeroconf 

(or Zero Configuration Networking) system, just like Microsoft Windows systems. (Microsoft refers to this as 

Automatic Private IP Addressing, but it’s also known as link-local.) In other words, if a bunch of computers 

plug into a hub or router on an ad hoc basis, without being configured and without a DHCP server operating, 

they will be able to network with each other. To make this work, each computer randomly assigns itself a 

unique IP address that starts with 169.254 with a subnet mask of 255.255.0.0. 

If you need to manually specify network details such as IP and router addresses, perhaps 

because you work in an office environment with nonstandard systems, start by speaking 

to your system administrator or technical support person to determine the settings you 

need. Ask the administrator for your IP address, DNS server addresses (there are usually 

two or three of these), your subnet mask, and the router address (sometimes referred to 

as the gateway address). The settings you will get from your system administrator will 

usually be in the form of a series of four numbers separated by dots, something like 

192.168.0.233. After you have this information, follow these steps:

1. Click the NetworkManager icon in the notification area, and then select Manual 

Configuration.

2. Click the Unlock button in the dialog box that appears. Supply your password 

when prompted, and then click the Authenticate button.
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3. Find your network device in the list. It should be referred to as Wired Connection. 

Click its entry, and then click Properties.

4.  In the dialog box that appears, uncheck the Enable Roaming Mode check box. This 

overrides NetworkManager’s capability to automatically manage the device and 

allows you to manually configure the device. In the Configuration drop-down list, 

make sure Static IP Address is highlighted. In the IP Address, Subnet Mask, and 

Gateway Address text boxes, fill in the relevant details. Figure 8-2 shows an example of 

these settings. Click OK after filling in the information.

Figure 8-2. Ubuntu will automatically work with DHCP networks, or you can define 

a static IP address.

5. Click the DNS tab in the Network Settings dialog box.

6. Click the Add button, and then type the first DNS address. Press Enter when you’ve 

finished. Click Add again, and enter the second DNS address, if you have been 

given one, and then enter a third if you were given one. 
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■Tip  If you’re using a static IP address with a router, such as that provided by a DSL modem, the DNS 

address will probably be the same as the router/gateway address.

7. Click the Close button.

Your network connection should now work. If you find it isn’t working, try rebooting. 

However, if your system administrator mentioned that a proxy must also be configured, 

you’ll also need to follow the instructions in the “Working with a Proxy Server” section 

later in this chapter. 

Connecting to a Wireless Network

A wireless (Wi-Fi) network is, as its name suggests, a network that does away with cabling 

and uses radio frequencies to communicate. It’s more common for notebooks and hand-

held computers to use wireless connections, but some desktop computers also do. Indeed, 

it’s increasingly the case that many workplaces are switching to wireless networking, 

eschewing old-fashioned, cable-based networking. 

■Note  Slowly but surely. Wi-Fi is replacing wired Ethernet networks, but there are many situations in which 

Wi-Fi networks are impractical or simply undesirable. For example, the metal infrastructure in some buildings 

means the signal becomes unreliable. Wi-Fi is also considered too insecure for some companies. The Wi-Fi 

signal often spreads to the street outside the building. Although such transmissions are nearly always secured, 

Wi-Fi security implementations have been broken, although WPA2 is considered secure right now. Ethernet 

might be considered old technology, but trying to steal data from physical cables is an order of magnitude 

more difficult, to the point of being practically impossible. 

Notebooks and PDAs typically use built-in wireless network devices, with an invisible 

antenna built into the case. However, some notebooks might use PCMCIA cards, which 

will have an external square antenna, and some desktop computers might use PCI-based 

wireless cards, which have external rubber/plastic antennas, in the style of old cell phones. 

Ubuntu includes support for most wireless network devices. However, it’s possible to 

use Windows wireless network device drivers for unsupported hardware. Also, sometimes 

Ubuntu appears to support a wireless network device, in that it identifies it and lets you 

configure it, but you might find that it simply doesn’t work (or works very badly, perhaps 

with an intermittent connection). In this situation, you can also try installing Windows 

drivers. See the “Installing Windows Wireless Network Device Drivers” section later in this 

chapter for details.
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■Note  Ubuntu is rare in the Linux world in that it uses some proprietary (closed source) wireless device 

drivers by default. Ubuntu is, after all, an open-source operating system and is committed to the goals of 

open-source software. The use of proprietary drivers is a necessary evil because not all devices have open-

source drivers right now, and not all open-source drivers support all the functions you might be used to (typically 

they might not support the WPA functionality of your Wi-Fi device, for example). The use of proprietary drivers 

is only a stopgap measure, and it’s hoped that open-source driver development will catch up, making propri-

etary drivers redundant. 

Connecting to a wireless network device is easy with NetworkManager. Just click the 

NetworkManager icon, and you will see the available Wi-Fi networks in the Wireless Network 

list. Networks protected with WEP/WPA will have an icon of a padlock. Those that are 

“open” will not have this icon.

You might see many Wi-Fi networks listed, depending on your location. The wireless 

base stations are identified by their Service Set Identifier (SSID) or sometimes ESSID, with 

E standing for Extended. 

If the SSID you would like to connect to is not listed by NetworkManager, it could mean 

that your wireless base station isn’t set to broadcast its SSID or, worse, Ubuntu’s Wi-Fi 

drivers aren’t functioning correctly. If it’s the former, all you need to do is right-click the 

NetworkManager icon and select Connect to Other Wireless Network. Then, in the new 

dialog box, type the SSID under Network Name, set Wireless Security to none or the 

appropriate security type, fill in the other information depending on the type of wireless 

security you selected, and click Connect. If it’s the latter, you may need to use a Windows 

driver, as described in the next section.

■Tip  If you are not offered any wireless networks at all, ensure the wireless hardware is switched on. Some 

notebooks have a keyboard combination to turn it off to save battery power. Additionally, try right-clicking the 

NetworkManager icon and ensuring that the wireless networking hardware is activated. 

To connect to a Wi-Fi network, select the wireless base station you wish to connect to 

in the list. If it isn’t protected by WEP/WPA, you will be connected to it automatically. 

If the Wi-Fi network you wish to connect to is protected with WEP or WPA, a dialog box 

will appear, prompting you for the password/passphrase, as shown in Figure 8-3. In the 

Wireless Security field, make sure the correct type of security for the wireless network is 

selected—don’t assume it’s automatically correct! By default, the password/passphrase is 

obfuscated by circle characters so that anyone looking over your shoulder can’t see what 

you’re typing. If it helps (and if your shoulder is clear!), check the Show Password box. 

This can really handy when you’re typing a particularly long passphrase. 
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■Note  WEP keys come in either hexadecimal (hex) or plain text (passphrase) varieties. Hex keys look 

similar to this in their 128-bit form: CB4C4189B1861E19BC9A9BDA59. In their 64-bit form, they will be 

shorter and may look similar to 4D9ED51E23. A passphrase will take the form of a single short sentence. In 

home and office environments, WPA networks are usually protected with passphrases. In larger corporate or 

academic environments, you might find the network is protected with a WPA certificate.

Figure 8-3. Ubuntu is able to join WPA-protected wireless networks. 

When you’re finished, click the Connect button. You should see the NetworkManager 

icon start to animate as the program attempts to connect and find an IP address. After a 

few seconds, when the animation finishes and the icon switches to display signal bars, 

you should find yourself online. 

If your computer doesn’t seem to connect, try rebooting. If the hardware doesn’t work 

after this, it might be that the drivers Ubuntu installed by default are incompatible with 

your network device. In this case, you can try using a Windows wireless network device 

driver, as described in the next section.

Should you find yourself in the unusual situation of needing to specify the IP address, 

subnet mask, and gateway for a wireless connection, you can do so using the manual 

configuration mode of NetworkManager, as outlined in the “Configuring an Ethernet 

Network Device” section earlier in this chapter. Simply follow the instructions in that 

section, but select the Wireless Connection entry in the list, rather than Wired Connection. 

In the dialog box that appears, you’ll see additional areas where you can enter your SSID 

and WEP/WPA protection details. 
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WEP VS. WPA 

Some wireless networks are protected using either the Wired Equivalency Privacy (WEP) or Wi-Fi 

Protected Access (WPA) systems. WPA is effectively an updated version of WEP and offers stronger 

protection. There are actually two versions of WPA: WPA and WPA2. WPA2 is newer and corrected 

several security flaws in WPA. Both work in roughly the same way.

WEP and WPA encrypt the data being transmitted on the network, the idea being that it cannot be 

stolen by crackers with special equipment. Also, people can’t join the wireless network unless they know 

the encryption key, which is basically an access code. This prevents unauthorized people from 

accessing the network.

Of the two, you should ideally configure your Wi-Fi base station to use WPA, because, sadly, WEP 

can be compromised within five minutes using easily available software. However, the situation isn’t 

quite so clear-cut for some Ubuntu users. Not all of Ubuntu’s built-in Wi-Fi drivers support WPA. Some 

might claim to support it, but you might find they don’t work reliably. Unfortunately, the only way you will 

be able to find out if this is the case for you is to try to configure your network device and see what 

happens.

If you fall into the camp of not having good WPA support on your Ubuntu PC (and only a small 

percentage of users will), you might find WEP is your only reliable option, and you might therefore need 

to reconfigure your base station to use it. Our experience has shown that WEP has a very high success 

rate under Ubuntu. However, sometimes 128-bit WEP won’t work on some troublesome Wi-Fi devices, 

and you might need to switch your network to 64-bit WEP instead. 

WEP is a compromise in security terms, but try to remain realistic when considering your imme-

diate environment. If your wireless network is within your home, is it likely that the couple living next 

door will have the know-how to crack a wireless network connection? Are they likely to want to do so?

On the other hand, if you live in an apartment block with several other computer-literate people, or 

if you work in an office, the risk might be considerably higher. Some people suggest that breaking into 

wireless networks is almost a sport for certain individuals. If this is the case, and you feel you simply 

can’t use WEP, consider installing Windows drivers using NdisWrapper, as explained in this chapter. 

But whatever the case, bear in mind that confidential Internet connections, such as those for 

banking and shopping sites, are independently protected using a separate technology. See the sidebar 

titled “Secure Connections on the Net” later in this chapter for details.

Installing Windows Wireless Network Device Drivers 

NdisWrapper is effectively an open-source driver (technically described as a kernel module) 

that allows Linux to use standard Windows XP drivers for wireless network devices. You 

might describe NdisWrapper as being a translation layer between the Linux kernel and 

the Windows drivers, which can be installed using NdisWrapper’s configuration tools. 
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You should only use NdisWrapper in one of two situations:

• Your wireless network hardware simply isn’t recognized by Ubuntu, which is to say, 

all you see when you click the NetworkManager icon is a Manual Configuration 

option; you don’t see any wireless networks listed. Of course, you should first ensure 

that the wireless hardware in your computer is actually switched on—some note-

books offer the facility to deactivate it to save battery life. 

• Your network hardware is recognized by Ubuntu but fails to work correctly or 

adequately when you configure it. Perhaps it is unable to associate with wireless 

base stations, for example, or maybe you can’t connect to WPA-enabled base 

stations and consider WEP too insecure for your surroundings. If this is the case, in 

addition to installing NdisWrapper, you’ll need to undertake an additional step in 

order to blacklist the existing Ubuntu driver. 

Using NdisWrapper is relatively simple and just a handful of commands are required. 

However, getting hold of the necessary Windows driver files is harder work because, 

unfortunately, NdisWrapper isn’t designed to work with the usual method of driver distri-

bution: .exe files. Instead, NdisWrapper needs the specific .inf and .sys files that constitute 

the driver—effectively, the Windows system files. These are contained within the .exe file 

and must be manually extracted. 

■Note  Sometimes drivers are distributed as .zip files, in which case the relevant files are easy to get at. 

Keep your fingers crossed that this will be the case for your particular hardware!

NdisWrapper is far from perfect. Not all wireless devices have been proven to work 

with it, and it’s not necessarily the case that a driver available for Windows will work 

under Linux. Sometimes trial and error is required. Annoyingly, Windows drivers some-

times appear to work but then prove unreliable. Some might stop working. Some might 

even crash your system. The best plan is simply to give it a try. 

■Tip  NdisWrapper gets better and better with every new release. This is why it’s a good idea to update your 

system on a regular basis, as described in Chapter 9.

In the instructions in this section, we explain how to make an Atheros AR5008 wireless 

network device that’s built into an Apple MacBook work under Ubuntu using NdisWrapper. 

The instructions remain essentially the same for all types of wireless network hardware. 

However, some specific details, such as download addresses, will obviously differ.
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First, you’ll need to install the NdisWrapper software, and then you can install the 

necessary Windows drivers. These steps will make your wireless network device available 

under Ubuntu. Then you can follow the instructions in the previous section to connect to 

that wireless network. 

Installing the NdisWrapper Configuration Tools

NdisWrapper consists of two components: a kernel module and configuration tools. The 

kernel module comes as part of the default kernel package, so is installed by default, but 

you will need to download and install the configuration tools manually. To do so, using 

another computer that is already online (or by switching to Windows XP if you dual-boot), 

visit the following addresses using a web browser:

http://us.archive.ubuntu.com/ubuntu/pool/main/n/ndiswrapper/

ndiswrapper-utils-1.9_1.50-1ubuntu1_i386.deb

http://us.archive.ubuntu.com/ubuntu/pool/main/n/ndiswrapper/

ndiswrapper-common_1.50-1ubuntu1_all.deb

http://us.archive.ubuntu.com/ubuntu/pool/main/n/ndisgtk/ndisgtk_0.8.3-1_i386.deb

You’ll be prompted to download these files. Save the files to a floppy disk or USB memory 

stick, or burn them to a blank CD-R/RW disk. Then, on the Ubuntu computer, copy the 

downloaded files to the desktop. 

Next, open a terminal window (Applications ➤ Accessories ➤ Terminal), and type the 

following, which will install the new software:

cd ~/Desktop

sudo dpkg -i ndis*

You’ll need to enter your password when prompted. When the commands have finished, 

and you see the command prompt again, close the terminal window. 

Installing the Windows XP Drivers

Once the NdisWrapper configuration software is installed, you can install the Windows 

XP wireless network device drivers. There are several parts to the procedure:

• Identify the wireless network hardware, and then source the appropriate 

Windows driver.

• Extract the necessary .sys and .inf files from the driver archive (and possibly .bin 

files, although this is rare). 

• You may need to blacklist the built-in Ubuntu driver, so that NdisWrapper can 

associate with the hardware.

• Use the NdisWrapper configuration tool to install the Windows driver. 
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These steps are covered in the following sections. You will need another computer 

that’s already online to download some files and check the NdisWrapper web site for 

information. If your computer dual-boots, you can use your Windows setup to do this. 

Identifying Your Wireless Network Hardware and Sourcing Drivers

To identify the wireless network hardware for use with NdisWrapper, it’s necessary to 

discover two pieces of information: the make and model of the hardware and the PCI ID 

number. The former is the make and model of the hardware, as identified by Ubuntu as 

a result of system probing, rather than what’s quoted on the packaging for the wireless 

network device or in its documentation. These details discovered by Ubuntu will usually 

relate to the manufacturer of the underlying components, rather than the company that 

manufactured the hardware. The PCI ID is two four-digit hexadecimal numbers used by 

your computer to identify the device internally. The same PCI ID numbering system is 

used by both Windows and Ubuntu, which is why it’s so useful in this instance. 

You can find both the PCI ID and the make/model information using the Device 

Manager tool. Follow the instructions in the “Installing Device Manager” section earlier in 

this chapter if you haven’t already installed this program. Then follow these steps: 

1. Select Applications ➤ System Tools ➤ Device Manager. In the left column, find the 

entry that reads Network Controller, Networking Wireless Control Interface, or 

WLAN Interface. You might also look for USB Interface, PCI Bridge, or 802.11 to 

exhaust your search. Then look at the corresponding summary in the right column, 

where you’ll find the make and model of the hardware listed under the Vendor and 

Model headings. If no useful details are listed, you might need to click the parent 

entry in the list. On one test system, we found the WLAN Interface entry, but saw 

the make and model details only after we clicked the Ethernet Controller parent 

entry in the list on the left. 

2. Write down the make and model shown in Device Manager. For example, on a test 

notebook containing an Atheros wireless network device, the make and model 

read “AR5418 802.11abgn Wireless PCI Express Adapter.” Remember that these 

details don’t relate to those listed in the instruction manual or computer packaging 

(our notebook’s specification lists the hardware simply as “Built-in AirPort Extreme 

Wi-Fi”). This is because Ubuntu is identifying the hardware generically, reading 

information from its component hardware. 

3. Click the Properties tab of Device Manager (if this isn’t visible, click View ➤ Device 

Properties) and look through the information there for a line that begins info.udi. 

Look at the end of the line, and make a note of the two sets of characters that are sepa-

rated by an underscore and preceded by pci_. Look at Figure 8-4 for an example taken 

from our test machine. Yours may differ, but the line should always end with pci_ and 

then the digits. If it doesn’t, you have selected the wrong entry in the list of devices on 

the left. Try examining a different entry, such as the parent of the entry in the list. 
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Figure 8-4. Find the PCI ID of your wireless network hardware by looking at the end of the 

info.udi line. 

4. Write down the characters following pci_ at the end of the info.udi line. Written 

alongside each other, the two sets of digits that are separated by an underscore 

form the all-important PCI ID number. In written form, they’re usually separated 

by a colon. If either of the sets of letters or numbers is less than four characters 

long, simply add zeros before them in order to make four characters. For example, 

in Figure 8-4, the end of the info.udi line reads 168c_24. We add two zeros before 

24, making a complete PCI ID of 168c:0024. On another test PC, the end of the line 

read 168c_13. Adding two zeros before the 13 gives a PCI ID of 168c:0013. 

5. Using another computer that’s able to go online, visit http://ndiswrapper.

sourceforge.net/. On the main menu, click Documents/Wiki, and then click the 

List of Cards Known to Work link. This is a community-generated listing of the wireless 

network devices that have been proven to work with NdisWrapper. 
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■Tip  The URL in step 5 was correct as this book went to press. If you find it no longer accurate, search 

Google using “NdisWrapper list” as a search term. 

6. The “known to work” cards are grouped in alphabetical order. Select the appro-

priate list based on the card manufacturer’s name. (Remember to use the name 

you discovered using Device Manager in steps 1 and 2, and not the official name in 

the computer’s manual or packaging.) 

7. Using the search function of your browser (Ctrl+F within Firefox), look for the PCI 

ID number you noted earlier, in the format described in step 4. For the example in 

Figure 8-4, we would search for 168c:0024. In the list, look to match the following 

things, presented in order of importance:

• The PCI ID

• The model name of the wireless hardware, as reported by Device Manager (listed 

on the Summary tab)

• The manufacturer and model of the notebook, as mentioned on its case or within 

its documentation 

It’s likely many entries in the list may match your PCI ID, so search until you find 

the one that best matches the model of the hardware. If there are still many matches, 

search until you find an entry that matches the manufacturer and model of the 

notebook. You might not be lucky enough to find an exact match for the notebook 

manufacturer and model, however, and you might need to select the most likely 

choice. Use your common sense and judgment. If your notebook is manufactured 

by Asus, for example, but you can’t find the drivers for the exact model, then choose 

drivers for another Asus model. 

■Caution  Watch out for any mention of x86_64 in the description of the driver file. This indicates the entry 

in the list relates to 64-bit Linux. The version of Ubuntu supplied with this book is 32-bit. If you encounter an 

entry relating to x86_64, keep searching. 

8. Look within the entry in the list for a direct link to the driver file. Sometimes this 

isn’t given, and a manufacturer web site address will be mentioned, which you can 

visit and navigate through to the driver download section (usually under the Support 

section within the web site). Download the Windows XP driver release. 
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Extracting the Driver Components

Once the drivers are downloaded, you’ll need to extract the .sys and .inf file relevant to 

your wireless network hardware. These are all that NdisWrapper needs, and the rest of the 

driver files can be discarded. However, extracting the files can be hard to do, because 

often they’re contained within an .exe file. (Most driver .exe files are actually self-extracting 

archive files.) Additionally, the driver file might contain drivers for several different models 

of hardware, and it’s necessary to identify the particular driver .inf file relevant to your 

wireless network device.

If the driver you’ve downloaded is a .zip file, then your task will probably be much 

easier. Simply double-click the downloaded .zip file to look within it for the directory 

containing the actual driver files. 

If the driver is an .exe file, it’s necessary to extract the files within it. With any luck you 

might be able to do this using an archive tool like WinZip (www.winzip.com), assuming that 

you’ve downloaded the file using Windows. Simply open the archive using the File ➤ 

Open menu option within WinZip. You may have to select All Files from the File Type 

drop-down list in order for the .exe file to show up in the file list. However, if you’re using 

Windows, we recommend an open-source and free of charge program called Universal 

Extractor, which can be downloaded from www.legroom.net/software/uniextract. This 

program can extract files from virtually every kind of archive, including most driver instal-

lation files. Once it is installed, simply right-click the installation .exe file, and select 

UniExtract to Subdir. This will then create a new folder in the same directory as the down-

loaded file, containing the contents of the installer file. 

Once you’ve extracted the files within your downloaded driver file, look for the files you 

need. It’s likely those driver files will be contained in a folder called something like Driver 

or named after the operating system, like Win_XP. Once you’ve found the relevant directory, 

look for .inf, .sys, and .bin files (although you may not find any .bin files; they’re used in 

only a handful of drivers). You can ignore any other files, such as .cab and .cat files. Click 

and drag the .inf, .sys, and .bin files to a separate folder.

The task now is to find the .inf file for your hardware. If there’s more than one, you’ll 

need to search each until you find the one you need. You need to look for text that corre-

sponds to the PCI ID you noted earlier. Open the first .inf file in a text editor (double-

clicking will do this in Windows), and using the search tool, search for the first part of the 

PCI ID, as discovered earlier. For the example in Figure 8-4, we would search for 168c. If 

you don’t find it within the file, move on to the next .inf file, and search again. When you 

get a search match, it will probably be in a long line of text and to the right of the text VEN_. 

Then look further along that line to see if the second part of the PCI ID is mentioned, prob-

ably to the right of text that reads DEV_. In the case of the driver file we downloaded for the 

example, the entire line within the .inf file read as follows (the two component PCI ID 

parts are shown in bold):

%ATHER.DeviceDesc.0023%  = ATHER_DEV_0023.ndi,  PCI\VEN_168C&DEV_0024
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If you find both component parts of the PCI ID in the line, as in this example, then 

you’ve found the .inf file you need. (In fact, you’ll probably find many lines matching 

what you need, which is fine.)

You must now transfer the .inf file, along with the .sys and .bin files (if any .bin files 

were included with the driver) to the computer on which you want to install the drivers. 

This can be done by putting them onto a floppy disk, by burning them onto CD, or by 

using a USB memory stick. Create a new directory called driver on the desktop and save 

them there. 

Your procedure from this point depends on if Ubuntu recognized your wireless 

networking device when you first booted but was unable to make it work correctly. If it 

did then you will need to blacklist the built-in driver, so that NdisWrapper can associate 

with the hardware. If the device wasn’t recognized, you can skip straight to the “Using 

NdisWrapper to Install the Drivers” section. 

Blacklisting Existing Drivers

To blacklist the existing built-in driver that didn’t work with your wireless device, you 

need to find out the name of the kernel module and then add it to the /etc/modprobe.d/

blacklist file. Here are the steps:

1. Open Device Manager (System ➤ Administration ➤ Device Manager), and select 

the entry in the list for your wireless network device. This is the one you discovered 

in steps 1 and 2 earlier, in the “Identifying Your Wireless Network Hardware and 

Sourcing Drivers” section. 

2. Click the Properties tab (if this isn’t visible, click View ➤ Device Properties), and 

look for the line that begins info.linux.driver. Then look in the value column, 

and make a note of what’s there. For example, on our test notebooks, the value 

column read rt2500usb. Close Device Manager.

3. Open a terminal window (Applications ➤ Accessories ➤ Terminal). Type the 

following to open the blacklist configuration file in the Gedit text editor:

 gksu gedit /etc/modprobe.d/blacklist

4. At the bottom of the file, type the following on a new line:

blacklist modulename

Replace modulename with the name of the module you discovered earlier. For 

example, on our test system, we typed the following (as shown in Figure 8-5):

 blacklist rt2500usb



C H AP T E R  8  ■  G E T T I N G  E V E R Y T HI N G  U P  A N D  R U N N IN G 139

Figure 8-5. To stop Ubuntu from loading its own drivers, you’ll need to blacklist 

the module.

5. Save the file, and then reboot your computer. 

You should now find that the wireless network device is no longer visible when you 

click the NetworkManager icon, and all you see is a Manual Configuration option. This is 

good, because it means the hardware no longer has a driver attached, and you can now 

tell NdisWrapper to use the hardware. 

Using NdisWrapper to Install the Drivers

On the Ubuntu computer on which you wish to install the drivers, you should now have 

the .inf file from the previous steps, plus the .sys and possibly .bin files that constitute 

the driver. You should have copied these files from the removable storage device into a 

new folder on your desktop named driver. 

■Note  If you’ve used a USB memory stick to transfer the files, it should appear automatically on the desktop 

as soon as it’s inserted. When you’ve finished with it, right-click the desktop icon, and select Unmount. You 

must do this before physically removing any kind of USB memory device, as explained later in this chapter.
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To install the driver using NdisWrapper, follow these instructions:

1. Click System ➤ Administration ➤ Windows Wireless Drivers. Enter your password 

when prompted. 

2. Click the Install New Driver button. 

3. The Install Driver dialog box appears, prompting you to select the .inf file for your 

wireless device. Click the Location drop-down list to open a file browsing dialog 

box. 

4. Navigate to the .inf file you copied to your system, which you have placed in the 

driver folder on your desktop. Double-click the desktop folder, and then double-

click the driver folder listed in the right column. Select the .inf file you copied in 

the driver folder and then click the Open button.

5. Back in the Install Driver dialog box, click the Install button.

6. At this point, you should see the driver listed at the left column of the Wireless 

Network Drivers dialog box. It specifies the name of the driver installed and 

whether the hardware is installed. If it says the hardware isn’t installed, you’ve 

probably selected the wrong .inf file, or might be using the wrong driver file. 

Return to the previous sections and try to get an alternative Windows driver. 

7. No reboot is necessary and your wireless network card should work immediately. 

To test if the driver works, click the NetworkManager icon and see if there are 

wireless networks listed. If it works, click Close to exit the Wireless Network Drivers 

dialog box.

Following this, you should find the network device is available for configuration. 

Follow the earlier instructions for connecting to a wireless network. 

Removing NdisWrapper Drivers

As mentioned earlier, although NdisWrapper can solve a lot of headaches with nonworking 

wireless hardware, it isn’t perfect. You might find that the Windows driver you install 

simply doesn’t work. In such a case, you can download a different version of the driver 

and try again. But first you’ll need to remove the existing driver. 

Select Click System ➤ Administration ➤ Windows Wireless Drivers and enter your 

password when prompted. In the Windows Network Drivers dialog box, select the driver 

you want to remove in the left column and click Remove Driver. Click Yes when prompted 

to confirm the removal. Click Close to exit the tool.



C H AP T E R  8  ■  G E T T I N G  E V E R Y T HI N G  U P  A N D  R U N N IN G 141

SECURE CONNECTIONS ON THE NET

For home users, the use of online banking services involves the transfer of confidential data. So is this a 

good reason to use the strongest form of wireless network encryption with your broadband router? No it 

isn’t. In fact, it makes no difference. 

This is because the transfer of confidential or financial data across the Web—to and from online 

banking sites, for example—is nearly always protected by Secure Socket Layer (SSL) HTTP. This works 

across any type of network connection, including wireless and Ethernet, regardless of whether the 

connection has its own protection. 

You can tell you’re browsing a site that’s using SSL because the address will begin with https. 

Additionally, most browsers display a padlock symbol at the bottom of the screen (the Firefox browser 

will also turn the background of the address bar yellow). Accessing such sites should be safe, even if 

your wireless network connection is “open,” which is to say it isn’t protected with either WEP or WPA.

Similarly, although online shopping sites might not use SSL while you’re browsing, when it’s time 

to pay, they always use SSL. This ensures your credit card details are encrypted. If the store doesn’t 

adopt an https:// address when you click to visit the virtual checkout, you shouldn’t shop there! 

So do you even need WEP or WPA protection if you simply use your wireless connection to browse 

the Internet? Yes. In addition to the risk of unauthorized users hopping onto your connection if it isn’t 

protected, some web mail services transfer your username and password “in the clear,” which is to say 

without using SSL. This means your information could be picked up by an eavesdropper. In the case of 

Hotmail and Yahoo Mail, you can select secure login, but it isn’t activated by default. Google Mail appears 

to use SSL all the time for login, but after this, your e-mail messages are transmitted across the Internet 

in the clear and, in theory, anyone, anywhere can eavesdrop.

Using Dial-Up Telephone Modems

In our world of high-speed broadband connections, we sometimes forget that a sizable 

minority of people use telephone dial-up to connect to an ISP.

For such people, Ubuntu offers good and bad news. The good news is that the Ubuntu 

software repository includes fuss-free software that can be used to configure connections 

and dial-up with the click of a mouse. The bad news is that, taken as a whole, Ubuntu 

support for dial-up modems isn’t very strong. 

If your modem is external and connects to the serial port, then there’s a very good 

chance Ubuntu will work fine with it. However, if the modem connects to the USB port, is 

built into your computer, or is provided on a PCMCIA card, then Ubuntu support is less 

certain. This is because many modems need additional and specialized configuration. See 

the sidebar titled “Winmodems.”

There’s no quick way to find out if your modem is supported, other than to follow the 

instructions in this section and attempt to use it. To follow the instructions, you’ll need 

access to a computer that’s already online to download a software package. If you dual-

boot with Windows, you can use it to download the software. 
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To configure your modem once the software is downloaded, you will need three pieces 

of information: the telephone number you should use to dial up, your username, and your 

password for your ISP (not your Ubuntu login username and password!). 

WINMODEMS

Some years ago, hardware manufacturers realized that they could produce dial-up modems more cheaply if 

they shifted the hard work of decoding the signal onto the computer’s operating system. With the work 

off-loaded, the modem’s circuitry could contain fewer and simpler components, thus saving money. 

For this to work, a special hardware driver was needed that effectively works as a middleman, 

handing the decoding work to the computer’s CPU. Unlike with other hardware drivers, these modem 

drivers aren’t around simply to make the hardware work with the operating system. Effectively, the 

drivers for such modems are a separate piece of software within themselves. 

Because of their need for this special driver software, which usually runs only on Windows, the 

modems are known as winmodems. 

As you might anticipate, using the modems under Linux presents many problems, chief among 

them being that Windows and Linux are two separate operating systems and, generally speaking, are 

incompatible. Although solutions exist and the problems aren’t insurmountable, setting up a winmodem 

under Linux often involves quite a lot of additional configuration. 

There are many types of winmodems, all of which need to be configured in different ways. An 

excellent web site exists that provides both step-by-step information and the necessary software. Using 

a computer that can get online, visit http://linmodems.org. Additionally, the user-friendly guide at 

http://linmodems.technion.ac.il/first.html might also be of help. As always, searching 

the Ubuntu forums (www.ubuntoforums.org) and specifying the make and model of your modem is 

also a good idea, because it’s almost certain that at least one other person will have tried to make the 

modem work under Ubuntu. 

Here are the steps necessary to configure a modem to dial up. You should ensure that 

your modem is plugged into the phone socket and is powered up. These instructions 

involve downloading the GNOME PPP dial-up tool, which will handle your dial-up requests. 

1. Using another computer that’s already online (or by switching to Windows if you 

dual-boot), visit the following address using a web browser. You’ll be prompted to 

download a file. Save the file to a floppy disk or USB memory stick, or burn it to a 

blank CD-R/RW disk. This is necessary because you’ll need to transfer the file to 

your Ubuntu computer.

http://us.archive.ubuntu.com/ubuntu/pool/universe/g/gnome-ppp/

gnome-ppp_0.3.23-1_i386.deb

2. On the Ubuntu computer, copy the downloaded file to the desktop. 
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3. Open a terminal window (Applications ➤ Accessories ➤ Terminal), and type 

the following:

sudo dpkg –i Desktop/gnome-ppp_0.3.23-1_i386.deb

You’ll need to enter your password when prompted.

4. You’ll find GNOME PPP on the Applications ➤ Internet menu. When the program 

starts, click the Setup button. 

5. In the Setup window, click the Detect button. This will probe your modem and 

change GNOME PPP’s configuration settings to match. Once probing is complete, 

remove the check from Wait for Dialtone, but don’t change any other settings on 

the Modem tab.

6. Click the Options tab. Put a check alongside Dock in Notification Area. Then click 

the Close button. 

7. In the Username, Password, and Phone Number fields, enter the relevant details, 

as illustrated in Figure 8-6. Remember that you should enter your dial-up username 

and password here, and not your Ubuntu username and password! Don’t forget to 

add any additional numbers to the front of the phone number if it’s necessary to 

deactivate call waiting or similar services on your phone line. It’s also wise to put a 

check in the Remember Password box, so you won’t be prompted for your password 

each time you dial up.

Figure 8-6. GNOME PPP can be used to connect to the Internet if you use a 

dial-up modem.

8. Click the Connect button to dial up. Once you’re connected, you’ll see a new icon 

appear in the notification area. When you want to disconnect, right-click this icon 

and select the relevant option.

Following the initial setup, it makes sense to create a desktop shortcut for GNOME PPP. 

This can be done by clicking and dragging the icon from the menu to a convenient spot. 
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Working with a Proxy Server

Some networks in offices require that you use a web proxy (often referred to as an HTTP 

proxy). A proxy is a server computer that provides additional security by providing a single 

portal to all web pages. It also helps speed up Internet access by storing frequently accessed 

pages. This means that if ten people request the same web page, there’s no need to get the 

same ten pieces of data from the Internet. The proxy computer can send them its own copies. 

You’ll need to speak to your system administrator to see if your office uses a proxy. If it 

does, your administrator will most likely give you an address, which may take the form of 

a web address (a URL) or an IP address. Once you have this information, follow these steps 

to configure the proxy:

1. Open Network Proxy Preferences (System ➤ Preferences ➤ Network Proxy).

2. On the Proxy Configuration tab, choose one of the three types of proxy configuration:

• Direct Internet Connection is basically not using a proxy at all when accessing 

the Internet. 

• Manual Proxy Configuration enables you to set the proxy servers and respective 

ports for HTTP proxy, Secure HTTP proxy, FTP proxy, and Socks host. You can 

fill in this information based on the settings you received from your system 

administrator. If you were provided with one proxy for Internet access, check 

Use the Same Proxy for All Protocols and fill in the details for the HTTP proxy 

and port. If your proxy uses authentication, click the Details button. In the 

HTTP Proxy Details dialog box, check Use Authentication, and then supply the 

username and password. Click the Close button.

• Automatic Proxy Configuration allows you to enter the link (URL) to discover 

the proxy settings in your office. 

3. On the Advanced Configuration tab, you can set the list of sites that will bypass the 

proxy. By default, any site hosted on your computer is bypassed. You can add and 

remove sites as well. You normally add intranet (internal) web sites to this list.

4. Click the Close button after you’re finished making changes to the proxy settings.

■Tip  Some ISPs run proxy servers, too. However, unlike proxies in offices, it’s normally up to you whether 

you choose to use them. You might find that using a proxy speeds up your connection, especially when you 

access popular sites, so it’s worth trying out. To find out if your ISP offers a proxy, visit its technical support 

web pages or phone its technical support line.
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ADDITIONAL NOTEBOOK CONFIGURATION

Generally speaking, a notebook computer will not need any configuration above and beyond what’s outlined 

in this chapter. For example, if you have a wireless network card, you can simply follow the instructions 

in the “Connecting to a Wireless Network” section. 

You might also want to make use of the GNOME CPU Frequency Scaling Monitor. If you have a 

compatible CPU in your notebook (or even some desktop PCs), this tool lets you adjust the speed of the 

chip to save power. Most modern mobile-oriented CPUs support this function. Unfortunately, because of 

the possibility of crackers using it to slow down your system, the applet is considered a security risk. 

Before you use it, you must reconfigure your system to allow it to work. 

Open a terminal window (Applications ➤ Accessories ➤ Terminal), and type sudo 

dpkg-reconfigure gnome-applets. You’ll then be asked if you want to set suid root for the 

cpufreq-selector applet. Select Yes using the arrow keys, and press Enter. Reboot your computer, 

and then right-click a blank spot on the panel at the top of the screen. Click Add to Panel and, in the 

dialog box that appears, scroll down to the System & Hardware heading. Click the CPU Frequency 

Scaling Monitor icon, and click the Add button. To alter your CPU frequency, click the applet, and choose 

the clock speed setting you desire.

Configuring Power-Saving Features
Ubuntu includes a number of features that can utilize the power-saving features of your 

computer, including switching off the monitor after a set period of inactivity and placing the 

computer into standby mode, whereby only the RAM subsystem is kept powered. However, 

some quick configuration is necessary to set up the system just the way you want it.

■Tip  If your computer has a CPU that can adjust its clock speed on the fly, such as a mobile processor, Intel 

Core Duo, Intel Pentium M, AMD Turion, or AMD chip with the PowerNow! function, Ubuntu will automatically 

install software that will make this work. This software will run in the background. To see a live view showing 

the speed of your processor, right-click the panel, select Add to Panel, and choose the CPU Frequency Scaling 

Monitor under the System & Hardware heading. Note that to manually control the speed of the processor, you might 

need to undertake the steps described in the “Additional Notebook Configuration” sidebar. If you find that the 

computer subsequently crashes when you attempt to scale the processor speed, use the Synaptic Package 

Manager to install cpufreqd. This should fix the issue. As always, updating online might also provide a cure.

Using Power-Management Preferences
Depending on the degree to which your computer supports power-saving functionality, 

Ubuntu will let you configure your display to go into standby mode after a certain amount 
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of time and will also allow you to configure your notebook to enter sleep (standby) mode. 

In addition, if you use a notebook computer, Ubuntu might let you configure additional 

aspects of your computer, such as the display brightness. These functions are controlled 

using the Power Management applet. To start this, click System ➤ Preferences ➤ Power 

Management. If Ubuntu is installed on a notebook computer, you’ll see three tabs in the 

program window: On AC Power, On Battery Power, and General. If Ubuntu is installed on 

a desktop computer, you’ll see just the On AC Power and General tabs. 

■Note  Not all PCs are created equal when it comes to power-saving features. Some support more function-

ality than others. In addition, Ubuntu is compatible with most but not all power-management systems, and it 

might not be able to support certain power-management functionality on your system, even if such functionality 

normally works under Windows.

Notebooks have the additional tab because it’s possible to define two separate power 

management profiles: one for when the computer is plugged in and one for running on 

battery power. This makes sense, because you might never want your display to switch off 

when connected to an outlet, but it’s advisable that it should deactivate within, say, 

15 minutes of inactivity if the computer is running on battery power to extend the life of 

the battery. 

The three tabs of the Power Management applet are explained in the following sections.

On AC Power

If your computer is a desktop PC without a battery, you’ll see two options under the On AC 

Power tab: Put Computer to Sleep When Inactive For and Put Display to Sleep When Inac-

tive For. By clicking and dragging the sliders for these options, you can control the amount of 

time before each feature kicks in. By dragging each to the far right, you can set a value of 

Never, which will deactivate that feature. 

■Note  The sleep mode can be to either suspend to RAM (that is, standby) or hibernate. You can set this 

under the General tab, as discussed in a moment.

If your computer is a notebook computer, you’ll see some extra options. Depending on 

the technology used in your computer, you might see a Set Display Brightness To slider, 

which you can use to set the brightness of the screen when the power is connected. When-

ever AC power is connected, the display brightness will be changed to match this setting. 

You may see a When Laptop Lid Is Closed option, with a drop-down list. As it suggests, 

this will control what happens when the notebook is closed. Depending on the hardware 
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contained in your computer, you might have the choice of doing nothing, blanking the 

screen, suspending the computer (shutting down all systems but RAM), hibernating 

(suspending RAM to disk and turning off the notebook) and shutting down the computer. 

However, not all computers support each of these modes, so the choices you see might 

vary.

Additionally, you may see a Dim Display When Idle check box, which you can check to 

conserve power by dimming the screen when your system is idle. 

On Battery Power

The options under the On Battery Power tab, which will be present only on a notebook 

computer, are largely the same as those under the On AC Power tab, as you can see in 

Figure 8-7. These settings come into operation the instant the main power is disconnected 

from your notebook and the battery kicks in. 

Figure 8-7. Notebook users can define an additional power profile that will kick in when the 

battery is in use.

An extra option appears as the last item in the Actions section: When Battery Power is 

Critically Low. Here, you can opt to automatically suspend, hibernate, or shut down the 

notebook when the battery power is nearly gone. 

The check boxes at the bottom of the Display section could help save battery power 

considerably. You may check the Reduce Backlight Brightness option, which as it suggests, 

sets backlight brightness to a lower setting when you run on battery power. As with On AC 

Power, the Dim Display When Idle option may also be available for battery power.  
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■Caution  Be aware that sleep mode requires a little battery power to work and will eventually drain your 

battery, especially if it’s already on its last legs!

General

Under the General tab, you have options to customize button actions and notifications. 

These settings persist whether the computer is on AC or battery power.

In the Actions section, you can set what happens when the power button is pressed 

once the computer is active. Effectively, this controls whether or not pressing the button 

when Ubuntu is running should shut down the computer, suspend it, or hibernate it. You 

can select Ask Me, which will cause the standard Quit dialog box to appear (that is, the 

same dialog that appears if you click System ➤ Quit). You can also customize the action 

for the suspend button. The available actions are to do nothing, suspend, and hibernate. 

Hibernate will write the contents of RAM to the hard disk and then shut down the computer. 

Suspend will shut down most systems of the computer except for the RAM, which will be 

kept active. Then, when you press a key or move the mouse, the computer will wake up 

almost instantly as the subsystems are reactivated. 

■Caution  Hibernate doesn’t work on all systems. The best plan is to test it by selecting System ➤ Quit 

and selecting Hibernate. Even if Hibernate appears to work, there are reports of it being unreliable. Some 

users report that their computer occasionally fails to wake up, causing a loss of data. Therefore, you should 

always save any open files before using the hibernate function or before leaving your computer unattended 

for any period in which hibernate mode might kick in automatically. 

The General tab also lets you select whether the power icon is visible in the notification 

area. If you’re using a notebook, you can display the icon only when the battery is nearly 

drained, when your battery is charging or discharging, or regardless of the battery state. 

Desktop PC users can choose not to display the power icon, which makes sense. The most 

fuss-free option is perhaps Only Display an Icon When Charging or Discharging, which is 

selected by default.

Finally, there’s also an extra option you can check to play sounds when error events occur. 

■Tip  Clicking the power icon in the notification area lets you quickly hibernate or suspend the computer. 

Just select the entry from the menu that appears. 
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Spinning Down the Hard Disk

All modern hard disks come with the ability to spin down their motors to save energy. 

Then, when data is requested, the motors spin up again. There may be a slight delay while 

this happens, and some people dislike using disk spin-down because of this. However, on 

a notebook, it can lead to a substantial increase in battery life. On a desktop system, it’s 

worth considering, because over the lifetime of a computer, it can save a lot of electricity 

(and therefore money!).

The spin-down settings are contained in the /etc/hdparm.conf file, which you’ll need 

to edit by hand. Follow these steps to adjust the spin-down settings:

1. Open a terminal window (Applications ➤ Accessories ➤ Terminal) and type 

the following:

gksu gedit /etc/hdparm.conf

2. Click Search ➤ Find, and in the box, type spindown_time. 

3. Click the Find button. You should find that a line in the file is now highlighted. 

Close the Search dialog box. 

4. Change the line to remove the hash mark from the beginning, so it reads like this:

spindown_time = 24

You can alter the value to anything you want. Each time unit is five seconds, so 24 

equates to 120 seconds (24×5 seconds) or 2 minutes. To set a time of 20 minutes, 

enter 240 (240×5 seconds). If you specify a number above 240, the time units are 

increased to 30 minutes. In other words, a value of 241 will equate to 30 minutes, a 

value of 242 will equate to 60 minutes, and so on.

5. When you’ve finished, save the file.

6. Reboot for the settings to take effect. 

POWER SAVING: IS IT WORTH IT?

An average computer draws anywhere between 100 to 1,000 watts of power. An average incandescent 

light bulb draws around 150 watts of power, so you can see that, relatively speaking, computers are low 

power consumers compared to many household devices. However, it’s still worth considering employing 

power-saving techniques. You might not save yourself a lot of money, but if you switch on power saving, 

and your neighbor does too, and her neighbor does, then the cumulative effect will add up, and we can 

all contribute less toward global warming.
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Try to avoid leaving your computer turned on overnight or when you’re away from it for long periods. As 

well as saving power, switching off your computer will avoid wear and tear on its components. Although 

the CPU can work 24×7 without trouble, it’s cooled by a fan that’s a simple mechanical device. There 

are other fans in your computer too, such as the graphics card fan and case fan. Each of these will even-

tually wear out. If your graphics card fan stops working, the card itself will overheat and might burn out. 

The same is true of the CPU fan. However, by shutting down your computer overnight, you can effectively 

double the life of the fans and radically reduce the risk of catastrophic failure. Isn’t that worth considering?

Adding a Printer
Most people have a printer nowadays, and Ubuntu supports a wide variety of models—

everything from laser printers to color ink-jet models, and even some of the very old dot- 

matrix printers.

If you work in an office environment, you might be expected to access a shared printer. 

Sharing a printer is usually achieved by connecting the device directly to the network. The 

printer itself normally has special built-in hardware to allow this to happen. Alternatively, 

the printer might be plugged into a Windows computer, such as a Windows server (or 

even simply someone’s desktop PC), and shared so that other users can access it, a setup 

that is known as Windows printer sharing. Ubuntu will work with network printers of both 

types.

Configuring a Local Printer

A local printer is one that’s directly connected to your computer, normally via USB. Any 

printer you attach to your computer will be configured by Ubuntu automatically and 

ready to use immediately, as shown in Figure 8-8. 

Figure 8-8. The local printer is automatically configured when you connect the printer to the 

computer and then turn it on.

However, if the printer malfunctions when printing, such as churning out paper when 

a print job is sent to it, printing garbage, or not working at all, you can attempt to configure it 

yourself. To set up a local printer, follow these instructions:
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1. Click System ➤ Administration ➤ Printing. In the Printer Configuration window, 

click the New Printer button. You’ll see the message “Searching for Printers.” This 

might take a few moments to work through. 

2. In the New Printer dialog box, you need to select which printer to configure. The 

printers that Ubuntu detected are listed under Devices. Click the printer you want 

to use, and then click the Forward button to continue. You’ll see the message 

“Searching for Drivers.”

3. Select the printer manufacturer. By default, Ubuntu selects the manufacturer that 

best fits your printer, but you can select another manufacturer from the list. Alter-

natively, you can provide the PostScript Printer Description (PPD) file if the built-in 

drivers cannot operate your printer. When you’ve finished, click Forward.

■Tip  You can find PPD files on the CD that came with your printer or download them. OpenPrinting 

(www.linux-foundation.org/en/OpenPrinting) and Adobe (www.adobe.com/products/

printerdrivers/winppd.html) offer many printer drivers for download. 

4. Ubuntu again selects the detected model and corresponding driver for your printer, 

but you can change these selections. If you find the default driver simply doesn’t 

work correctly, try a similar but different model. Select the appropriate model in 

the Model list in the left column, and then select the appropriate driver for your 

printer from the Drivers list in the right column. Click the Forward button to 

continue.

5. You’ll be invited to give the printer a name. The default should be OK. You can fill in 

the Description and Location fields if you want, but these are necessary only if you 

intend to share the printer across a network. Click Apply when you’ve finished. 

■Tip  Sharing your printer on the network so that other computers can use it is simple: open the Printer 

Configuration window (System ➤ Administration ➤ Printers), select Server Settings in the list on the left, and 

put a check in the Share Published Printers Connected to This System box on the right. Then click the Apply button.

Once installation has finished, the printer will then appear in the Printer Configuration 

window, as shown in Figure 8-9. To see whether it’s working correctly, select the printer 

under Local Printers in the left column, and then click the Print Test Page button on the 

Settings tab on the right side of the window.
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Figure 8-9. Once the printer is configured, it appears in the tree list on the left column of the 

Printer Configuration window. 

If the printer is installed correctly, you should find yourself with a test page showing 

color gradations.

If the printer hasn’t been installed correctly, it either won’t work at all or will start spewing 

out page after page of junk text. If this is the case, click Cancel Tests (where the Print Test 

Page button used to be), and then turn off the printer. Delete the printer driver by selecting 

the printer in the list on the left and clicking the Delete button at the top of the Printer 

Configuration window. Then repeat the installation steps, this time trying different settings.

Configuring a Network Printer

A network printer is one that is not directly connected to any computer. Instead, it connects 

to the network via an Ethernet cable. In this way, all computers in the office will be able to 

use it. If the network printer is directly connected to a computer, it will probably be shared 

via Windows/SMB. In this case, follow the instructions in the next section.

Some printers have the required server hardware built in, but others might use a special 

print server module that attaches to the printer’s USB or parallel printer port. Ubuntu can 

work with both types of hardware.
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Ubuntu is compatible with Unix (LPD), HP JetDirect, and Internet Printing Protocol 

(IPP) server types. These are the most ubiquitous types currently in use for stand-alone 

printer servers.

Before beginning, you’ll need to find out the printer’s network address and, if relevant, 

the queue name or the port number. You should be able to find out these details by speaking 

to your network administrator or the person who configured the printer.

Follow these steps to configure a network printer:

1. Click System ➤ Administration ➤ Printing. In the Printer Configuration window, 

click the New Printer button.

■Tip  You can add as many printers as you want. You could configure a local printer (that is, one attached 

to your computer), and then configure a network printer. 

2. In the Devices list of the New Printer dialog box, select the type of shared printer 

you want to connect to. If you’re unsure of which to choose, try Internet Printing 

Protocol (IPP). If you wish to connect to a Hewlett Packard (HP) printer with an HP 

print server attached, select AppSocket/HP JetDirect. (You could also choose LPD/LPR 

Host or Printer, but this has long been replaced by IPP.) 

3. In the Host field, enter the network address of the printer. In the case of HP JetDirect, 

the default port number should work, unless you have been specifically told to 

enter a different number. Depending on which server option you chose, you may 

also need to enter the queue name. If it’s IPP, you need to provide the host and 

printer queue, but Ubuntu makes it easy to set this up. Just type the network 

address in the Host field, and then click Find Queue. The IPP Browser dialog box 

will pop up and display a list of printer queues. Select a printer queue, and then 

click OK. Ubuntu will update the entries in the Host and Queue fields automati-

cally. Click the Verify button to check if you can access the printer with the updated 

settings. Should it fail, try changing the Host field to the host’s IP address (ask your 

system administrator for this information if you don’t have it). Once you have the 

correct settings, click Forward.

4. As prompted, choose the printer manufacturer, printer model and driver, and 

printer name, just as if you were configuring a local printer. See steps 3, 4, and 5 in 

the previous section for guidance. Click the Apply button after you’ve made your 

selections. 

5. When the printer is installed, select the printer from the list in the Printer Configu-

ration window, and then click Print Test Page. 
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If the printer doesn’t work, it’s likely that you set the wrong server type. Try an alterna-

tive type; if you chose IPP the first time, try App Socket/HP JetDirect the second time. 

Many print servers can emulate a variety of modes, so trying a different setting may work.

If the printer starts spewing out page after page of text, it’s likely that you selected an 

incorrect printer driver. Cancel the job at the printer by clicking Cancel Tests. Next, select 

the printer in the list on the left and click the Delete button at the top of the window to 

remove the printer. Then repeat the installation steps, this time trying an alternative driver.

Configuring a Windows/SMB Shared Printer

A Windows (or SMB) printer is one that’s directly connected to a computer, and then 

made available across the network via the network sharing function of the operating 

system. Effectively, the computer acts as the printer server. Often, in corporate environ-

ments, such printers are attached to server computers, but an individual may share the 

printer attached to a workstation.

In a home situation, a Windows/SMB share is an excellent and inexpensive way of 

sharing a printer among many computers. The printer is attached to one PC, and, as long 

as that computer is switched on, the printer will be available to the other computers in the 

household.

Assuming that the printer has been correctly set up to be shared on the host computer, 

connecting to a Windows/SMB printer share is easy. In fact, you may find that Ubuntu 

finds the printer in the background and sets it up automatically! If you find the printer is 

available when you choose to print from an application, try it out and see if it works.

However, more likely, you’ll need to add it manually. Follow these steps to set up a 

Windows/SMB shared printer:

1. Click System ➤ Administration ➤ Printing. In the Printer Configuration window, 

click the New Printer button.

2. In the Devices list, select Windows Printer via SAMBA.

3. Click the Browse button to probe the network to see if any printer shares are available. 

More than one might appear, so navigate through the printer shares until you find 

the desired printer, as shown in Figure 8-10. Select the printer and click the OK 

button. If you cannot find the printer share listed in the SMB Browser dialog box, 

you may need to enter the details in the smb:// field manually. This entry will 

probably take the form of the address followed by the printer name (for example, 

officepc/epson). Speak to your system administrator or the individual in charge of 

the shared printer to find out what these are.



C H AP T E R  8  ■  G E T T I N G  E V E R Y T HI N G  U P  A N D  R U N N IN G 155

Figure 8-10. Ubuntu should be able to automatically detect any Windows or SMB 

shared printers on your network.

4. Click the Verify button to check if the printer is accessible. If it succeeds, skip to 

step 6. If it fails, you may need to supply the username and password to access the 

shared printer, as described next. 

5. Check the Authentication Required check box. In the Username and Password 

fields, type the username and password required to access the shared printer. 

These can be the login details of any user of the computer or, if the shared com-

puter and printer are configured for Guest access, you can try typing Guest for the 

username and leaving the Password field blank. Once the details have been filled 

in, click Forward.

6. As prompted, choose the printer manufacturer, model, driver, and name, just as 

if you were configuring a local printer. See steps 3, 4, and 5 in the “Configuring a 

Local Printer” section for guidance. Click the Apply button after you’ve made your 

selections. 

7. When the printer is installed, select the printer from the list in the Printer Configu-

ration window, and then click Print Test Page. 
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If the printer makes a noise as if to start printing but then decides not to, you might 

need to change a setting on the Windows machine. Click Start ➤ Printers and Faxes, and 

then right-click the shared printer’s icon. Select Properties and click the Ports tab in the 

Properties window. Remove the check in the Enable Bidirectional Support box, and then 

click OK. Then restart both the Windows and Ubuntu computers.

If the printer starts spewing out page after page of text instead of the test page, it’s likely 

that you selected an incorrect printer driver. Cancel the job at the printer by clicking 

Cancel Tests. Next, select the printer in the list and click the Delete button at the top of the 

Printer Configuration window to remove the printer. Then repeat the installation steps, 

this time trying an alternative driver.

Administering a Printer

Like Windows, Ubuntu uses the concepts of print queues to handle printing. When you 

print from an application, the print job is actually held in the print queue. If the queue is 

empty, then the job is printed immediately. If there are already jobs waiting to be printed, 

or if a print job is already in progress, then the new job is added to the queue.

■Tip  If you have more than one printer installed (maybe you have a printer attached to your PC but also print 

to a network printer), you can set one as a default, which will automatically be chosen whenever you choose 

to print. Simply click System ➤ Preferences ➤ Default Printer. Then select the printer from the list, click the 

Set Default button, and close the program window. 

When you print a document, the Document Print Status icon appears in the notifica-

tion area (it looks like a printer). Double-click the icon to view the jobs waiting to be printed, if 

any. Right-clicking a job displays a context menu that lets you cancel, pause, and resume 

the job.

When you attempt to print from applications, Ubuntu will display a unified printer 

interface, as you might be used to in Windows. You will find similarities when you print in 

Gedit, GIMP, and Firefox. The only exception is OpenOffice.org, which offers its own 

simplified print dialog box. 

Most applications that use the unified print dialog box will provide additional unique 

options related to that particular application. For example, GIMP offers quality settings 

useful for printing high-resolution photographs, and Gedit offers functions related to 

basic text printing. 

Ensure you select your printer in the list on the left of the print dialog box (on the 

General tab) in order to see all the available options. 



C H AP T E R  8  ■  G E T T I N G  E V E R Y T HI N G  U P  A N D  R U N N IN G 157

Using Digital Cameras, MP3 Players, and 
USB Memory Sticks
Removable storage is the term applied to peripherals that you might attach to your computer 

that contain their own storage. Examples include USB memory sticks, external hard 

drives, MP3 players, digital cameras, and photographic memory card readers. You might 

also find some devices like mobile phones are treated as removable storage devices when 

you attach them directly to your computer. 

When you attach any removable storage device, Ubuntu does the following:

• Displays an icon on the desktop, which you can double-click to view the removable 

storage device contents.

• Adds an icon to Nautilus’s Computer view, which can be accessed by clicking Places ➤ 

Computer (or Go ➤ Computer in a currently open Nautilus window). As with 

the desktop icon, double-clicking this will display the contents of the removable 

storage device. The Computer view is a good way to see at a glance all removable 

storage devices attached to your computer.

• If the removable storage device contains digital images (if it’s a digital camera, for 

example), and you view the contents using a Nautilus window, an orange bar will 

appear across the top of the window, alongside a button asking if you want to 

import the images to the F-spot photo library program.  You’ll learn more about this 

in Chapter 20, which provides a concise guide to cataloging and manipulating your 

digital images. 

The contents of the removable storage device will be accessible in exactly the same way 

as any other files on your system. You should be able to copy, delete, and create files on 

the device, provided the device isn’t read-only (if the read-only switch isn’t set on a USB 

memory stick, for example). If the device contains MP3 tunes, you should be able to double-

click them to play them, provided the playback codecs are installed (see Chapter 18). 

However, a very important rule must be followed when you’ve finished with removable 

storage devices under Ubuntu: the device must be unmounted before you physically 

remove it. This applies also to memory cards that are inserted into a card reader—before 

removing any card from the card reader, it must be unmounted. 

This is quite simple to do. Just right-click the icon on the desktop or within the Computer 

window and select Unmount Volume. Make sure that you save and close any files that you 

may have been working on before you do so, or you may see an error message. You’ll need 

to close any Nautilus windows that might have been browsing the storage device too. 

If you’ve used the command line to manipulate files on the removable storage device, 

remember to close any running programs in the terminal window. You’ll also need to 

switch out of the removable storage device directory before you’ll be allowed to unmount 

it (alternatively, you can simply close the terminal window). 
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Following this, you can safely physically remove the card or unattach the device. Rein-

serting it will make it available once again.

■Caution  Be very careful not to remove a memory card from a card reader while you’re writing or reading 

from it on your PC. This will most likely damage the card irreparably. At the very least, it will wipe the contents 

of the card, so you’ll lose your photographs.

Configuring a Scanner
Although scanners have fallen out of favor recently with the advent of digital photography, 

they’re vital for getting nondigital photos and old documents onto your PC.

A lot of flatbed scanners can be made to work under Ubuntu, but not all types 

are supported. You can check the list of currently supported scanners by visiting 

www.sane-project.org. Additional models are added to the list all the time, and this is 

another reason to make sure your system is completely up-to-date (see Chapter 9 and 

Appendix D; the former explains how to update your system software, while the latter 

describes how to update to the latest version of Ubuntu).

The best test of whether your scanner is supported under Ubuntu is simply to see if it 

will work. Scanning within Ubuntu is handled by the XSane utility. This is a stand-alone 

program that operates like the TWAIN drivers that you might have used under Windows. 

■Tip  XSane is even capable of optical character recognition! Simply use the Synaptic Package Manager to 

download and install the gocr program. Then, after you scan an image, in the viewer window, select File ➤ 

OCR - Save As Text. 

To configure a scanner and scan images, follow these steps:

1. Select Applications ➤ Graphics ➤ XSane Image Scanner. On startup, the program 

will attempt to detect your scanner. If it finds a compatible model, XSane will start. 

If the scanner isn’t recognized, a dialog box will appear telling you so.

2. XSane consists of a handful of windows, including the main program window, the 

Standard Options dialog, the Histogram window, and the Preview window. You can 

close the Standard Options and Histogram windows for the moment and concen-

trate on the main XSane program window, which should be similar in appearance 

to the TWAIN scanner drivers you might have used under Windows.
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3. At the top of the window is the automatic document feeder option, where you can 

set the number of pages in the feeder to scan in one sitting. If your scanner does 

not have an automatic document feeder, you can do this manually by changing the 

paper yourself immediately after the previous paper has been scanned.

4. Beside the automatic document feeder option is the XSane mode drop-down list. 

Here, you can select from a variety of scanning modes, such as those to scan docu-

ments for faxing. However, in most cases, the Save setting is best. This lets you 

preview your scans and then save them to disk if you’re happy with them.

5. Beneath this is the filename field. Here you should type the filename you wish to 

use for the scanned file. XSane can save in a variety of file formats, and it detects 

which you want to use from the file extension you choose. For example, typing 

picture.jpg will cause the picture to be saved as a JPEG image. Typing picture.tif 

will cause the image to be saved as a TIFF file. 

6. Beneath the filename field, on the left, is the filename number count. This is used 

if you wish to scan many images in succession—a number is added to the end of 

the filename, and this control configures the increment. A setting of +1 is fine. 

7. Beneath the filename field, and to the right, is the type drop-down list, by which 

you can force a certain file type to be used when saving files. However, leaving this 

at the default By Ext is best. This means that, as mentioned previously, you can 

define the type of image saved by the filename extension. 

8. Next down is the color/monochrome drop-down list. Here, you can select to scan 

Lineart (binary), Gray (grayscale), Halftone, or Color. If you select anything other 

than Lineart, additional sliders will appear to let you control the gamma, brightness, 

and contrast of the scanned image, in that order. In addition, several other buttons 

will appear at the bottom of the program window, all of which you can leave at 

default settings. Remember that hovering the mouse cursor over each will explain 

what it does. 

9. Next is the source medium type drop-down list. Here you can specify the type of 

medium you are scanning—whether it’s a full-color picture, a slide/transparency, 

or a negative. For normal operations, select Full Color Range.

10. Next is the dots per inch (DPI) setting. Generally speaking, 300 DPI is acceptable 

for scanned photos, while 150 DPI will be acceptable for artwork such as diagrams.

11. To scan a preview, click the Acquire Preview button within the preview window. 

The results should be something similar to what’s shown in Figure 8-11. 
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Figure 8-11. The XSane program works a little like TWAIN drivers under Windows and makes 

scanning easy.

12. When the preview scan has finished, you can adjust the brightness/contrast set-

tings using the sliders in the XSane program window (assuming you selected color 

scanning earlier). You should also click and drag to crop the image in the preview 

window, if XSane doesn’t do so automatically. 

13. When you’re satisfied with the preview, click the Scan button in the main XSane 

program window. The image will then be scanned at your chosen resolution and 

saved to your /home directory, using the filename you specified earlier. 

Installing 3D Drivers and Activating Desktop 
Visual Effects
The modern trend is for operating systems to incorporate flashy graphical effects into 

ordinary desktop functions. For example, when windows are minimized in Windows 

Vista, they physically shrink and fade down to the taskbar. Under Mac OS X, program 
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windows appear to be “poured” into the Dock when minimized. In Windows Vista, when 

you press Alt+Tab to switch through open programs, the program windows are previewed 

vertically in a graphical arrangement, and you can flick through them, rather like searching 

through a card index. These effects are achieved using the 3D processing power of the 

computer’s graphics card, even though the effects aren’t necessarily 3D in nature. 

■Note  On a technical level, the technique is known as compositing. What you see on the screen is first 

drawn in the graphics card memory and then transferred to the screen, rather than everything simply being 

drawn directly onto the screen. 

Ubuntu includes similar desktop visual effects, courtesy of a system called Compiz 

Fusion (www.compiz-fusion.org). However, all desktop visual effect systems have a couple 

requirements, and these apply to Ubuntu as well:

• For desktop effects to work, your graphics card (or motherboard graphics chipset) 

must be comparatively recent. Examples include the ATI Radeon, nVidia GeForce, 

and Intel GMA product lines. Most graphics cards manufactured within the last two 

or three years with a graphics processing unit (GPU) should be adequate, and very 

recent models definitely will work. 

• The correct graphics drivers must be installed. Some of Ubuntu’s built-in graphics 

drivers lack the necessary 3D functionality to support desktop effects. Currently, 

Intel GMA and some ATI Radeon graphics cards are supported by default because Intel 

and ATI provide open-source 3D-capable drivers. For other hardware, including 

nVidia cards, you will need to manually install a proprietary driver, which is not 

difficult to do.

■Note  You only need to install the proprietary driver if you wish to utilize desktop visual effects. Ubuntu 

includes a default 2D graphics driver that provides excellent functionality for everyday desktop use. 

Some proprietary 3D graphics drivers are provided under Ubuntu, but only if open-

source equivalents are missing. It is hoped that open-source drivers will one day replace 

the need for proprietary drivers.

So do you actually need to install new drivers? If you find that desktop effects are working, 

then the correct drivers are already installed. A good way to test this is to hold down Ctrl+Alt 

and then tap the left or right arrow key. This will switch to the next virtual desktop. If the 

entire desktop physically slides out of the way, then desktop effects are activated. If the 

desktop remains static and a small dialog box appears in the center of the screen to let you 

choose a virtual desktop, then desktop effects are not activated. 
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A utility called Hardware Drivers lets you manage proprietary drivers for your graphics 

card. This should appear in the notification area automatically immediately after installa-

tion if your hardware requires proprietary drivers. 

Follow these instructions to activate the proprietary graphics driver: 

1. Click the Hardware Drivers icon to run the Hardware Drivers program. If it’s not 

visible, click System ➤ Administration ➤ Hardware Drivers. 

2. Supply your password in the authorization dialog box and click OK.

3. In the Hardware Drivers window, check the Enabled box beside your graphics card 

device driver.

4. A dialog box appears, asking you to confirm that you want to enable the driver. It 

explains that enabling the driver enables visual effects on your desktop. Click the 

Enable button. 

5. The Summary dialog box appears to tell you what new software will be installed. 

Click the Apply button.

6. The driver will be downloaded and installed. Then the Changes Applied dialog box 

will appear to tell you that the changes are completed. Click the Close button.

7. In the Hardware Drivers window, click the Close button.

8. You need to restart the computer so that Ubuntu will use the new driver. Select 

System ➤ Quit, and then click Restart.

Once the new graphics driver is installed, desktop visual effects should start working 

immediately. If you experience seemingly random system-wide crashes or freezing after 

installing a 3D graphics driver, consider reverting to your old setup by using the Hardware 

Drivers program (System ➤ Administration ➤ Hardware Drivers) to disable the new driver. 

Unfortunately, in a small minority of cases, the proprietary driver can prove buggy. 

■Tip  On one of our test PCs, containing an nVidia GeForce 6600 graphics card, the Hardware Drivers 

program didn’t install the new driver as it should. This is probably a bug that might be fixed by the time you 

read this, but we got around it by manually installing the driver. The procedure is to open the Synaptic 

Package Manager (System ➤ Administration ➤ Synaptic Package Manager), search for the nvidia-glx-

new package, and mark it for installation. Then reboot. When the system is up and running again, start Hard-

ware Drivers, and once again put a check in the box alongside the graphics driver. If there’s already a check 

there, remove it and put it in again. Upon a second reboot, desktop visual effects should become operational. 
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Two modes of operation are available for desktop visual effects: Normal and Extra. 

Normal is the default and provides a good subset of the available effects: menus fade into 

view, program windows shrink when minimized, and so on. Extra provides a lot more 

effects, some of them rather extreme, such as wobbling when you click and move a window, 

and windows appearing to explode to the corners of the screen when maximized. To switch 

between the two settings, right-click the desktop, select Change Desktop Background, 

and then click the Visual Effects tab in the dialog box that appears. 

Configuring Bluetooth
Bluetooth is the short-range networking facility that allows various items of hardware to 

work with each other wirelessly. You can use Bluetooth for everything from file transfers 

between a mobile phone and computer to employing a wireless keyboard or mouse with 

your desktop computer.

For Bluetooth to work, both devices need to have Bluetooth support. Many mobile 

phones come with Bluetooth nowadays, as do an increasing number of notebook computers. 

It’s also possible to buy very inexpensive Bluetooth USB adapters.

Bluetooth support is built into Ubuntu and should activate automatically if Bluetooth 

hardware is present on your PC. You will know if this is the case because a Bluetooth icon 

will appear in the notification area. This is used to administer all Bluetooth devices that 

you might want to connect to your computer. 

Pairing Bluetooth Devices

When two pieces of Bluetooth-compatible hardware need to communicate on a regular 

basis, they can pair together, a process also known as pairing or bonding. This means that 

they trust each other, so you don’t need to authorize every attempt at communication 

between the devices. Indeed, some devices won’t communicate unless they’re paired in 

this way.

Pairing is very simple in practice and works on the principle of a shared personal ID 

number (PIN). The first Bluetooth device generates the PIN, and then asks the second 

Bluetooth device to confirm it. Once the user has typed in the PIN, the devices are paired. 

Pairing is easily accomplished under Ubuntu and doesn’t require any additional software.

As an example, the following are the steps for bonding a Nokia 6680 phone to an 

Ubuntu PC. Bonding for devices without a user interface, such as keyboards, is handled 

differently, as explained in the “Using a Bluetooth Keyboard or Mouse” section a little 

later in the chapter.
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1. Ensure the Ubuntu PC is visible, which is to say that other Bluetooth devices can 

detect it. Right-click the Bluetooth icon in the notification area, click Preferences, 

and make sure that the radio button alongside Visible and Connectable for Other 

Devices is selected. Click Close. 

2. It’s easiest to initiate pairing on the device you want to connect to the PC, which 

should then autosense the PC’s Bluetooth connection. You will need to discover 

how to do this on your particular Bluetooth device. On the Nokia 6680, we opened 

the menu and selected Connections ➤ Bluetooth. Then we pressed the right arrow 

key to select Paired Devices and selected Options ➤ New Paired Device ➤ More 

Devices. This made the phone autosense the Ubuntu PC, which was identified by 

its hostname, followed by -0. You might remember that the hostname was autoge-

nerated during installation of Ubuntu. It is normally your username followed by 

desktop. In our case, the Ubuntu PC was identified as ubuntu-desktop-0.

3. The Nokia 6680 then prompted us to create a PIN. You may find that some devices 

simply show a random PIN that you should write down. After entering our PIN on 

the phone, a comment box popped up on the Ubuntu computer, notifying us of a 

pairing request between Ubuntu and the mobile phone, as shown in Figure 8-12. 

Figure 8-12. A pairing request is easily accomplished through the Bluetooth applet.

4. We clicked the Enter Passkey button in the comment box and were prompted to 

input the same PIN we set earlier on the phone. We typed the same PIN and pressed 

OK. Following this, the two devices were paired. 

If you subsequently wish to remove the pairing, right-click the Bluetooth icon and 

select Preferences. In the list of Bonded Devices at the bottom of the dialog box, select the 

entry for your Bluetooth device and click the Delete button. Don’t forget to remove the 

pairing on the Bluetooth device, too. 

Transferring Files Between Bluetooth Devices

If you own a Bluetooth-equipped camera phone, you might be used to transferring 

pictures to your computer using Bluetooth. It’s by far the easiest way of getting pictures 

off the phone and avoids the need for USB cables or card readers. To transfer files via 

Bluetooth, you can use the Bluetooth applet.
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■Note  Some phones refuse to transfer files unless the phone and computer are paired, so follow the 

instructions in the previous section first. Phones like the Nokia 6680 don’t need pairing for file transfer, 

although each transfer will need to be confirmed manually.

Sending Files to a Ubuntu PC

Follow these steps to send files from a Bluetooth device to your PC:

1. Right-click the Bluetooth icon in the notification area and select Preferences. In the 

Bluetooth Preferences dialog box, click the General tab. Check Receive Files from 

Remote Devices. A bubble will appear that says that Ubuntu is ready to receive 

incoming files. Click Close in the Bluetooth Preferences dialog box. 

2. On the Bluetooth device from which you wish to send the file, start the file transfer. 

On the Nokia 6680, we selected the file and clicked Send ➤ Via Bluetooth.

3. A dialog box may appear on the Ubuntu computer asking you to confirm that you 

want to receive the file. Click OK. Once the file is received, the file will be copied to 

the desktop folder.

Sending Files from a Ubuntu PC to Another Device

There are two ways to send files to another Bluetooth device from your Ubuntu PC. The 

first is to use the Bluetooth applet. The second is to right-click the file in question and 

select Send To. The second method is useful if you wish to send many files at once, and 

you will have the option of automatically zipping the files into a single archive (but bear 

in mind that the Bluetooth device receiving the file will need to be able to subsequently 

unarchive the file). 

Using the Bluetooth Applet

Follow these steps to use the Bluetooth applet to send files:

1. Right-click the Bluetooth icon in the navigation area and click Send File.

2. In the Choose Files to Send dialog box, navigate to the file you want to send and 

click Open.

3. In the Select Device dialog box, select the target Bluetooth device and click the 

Connect button.

4. The target Bluetooth device might prompt you to accept or deny a file transfer 

request from Ubuntu. Choose to accept it.

5. After the file has been received by the Bluetooth device, click Close.
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Using the Send To Option

To use the Send To option on the context menu to send one or more files, follow these steps:

1. Either right-click an individual file or select several files and click one of them. 

Right-click and select Send To.

2. In the Send As drop-down list of the dialog box that appears, select Bluetooth 

(OBEX Push). In the Send To drop-down list, ensure that your Bluetooth device is 

selected. 

3. If you’re sending several files, you can put a check in the Send Packed In check box. 

This will create a new single .zip archive and add the files to it automatically. 

Otherwise, each file will simply be sent one after the other. 

4. Click the Send button. You may be prompted to authorize receipt of the files on the 

Bluetooth device, so do so. Bear in mind that transfer of many files may take some 

time because Bluetooth is not a particularly speedy form of data transfer.

5. Once the file transfer is complete, click the Close button. 

Using a Bluetooth Keyboard or Mouse

Your Bluetooth-equipped keyboard or mouse may work automatically under Ubuntu. 

However, if not, you may need to pair it to your PC, as follows:

1. Before you can pair your keyboard or mouse with Ubuntu, you must edit a system 

configuration file. Open a terminal window (Applications ➤ Accessories ➤ Ter-

minal) and type the following, which will open the file in the text editor:

gksu gedit /etc/default/bluetooth

2. In the document that appears, look for the line that reads HIDD_ENABLED=0 and 

change the 0 to a 1, so it reads HIDD_ENABLED=1. Then save the file and quit Gedit. 

3. Ensure the Ubuntu PC is set to be discoverable. Right-click the Bluetooth icon in 

the notification area, click Preferences, and make sure that the radio button 

alongside Visible and Connectable for Other Devices is selected. Click Close. 

4. Switch your keyboard or mouse to discoverable mode. Read the instructions for 

your device to find out how this is done. On an iGo Stowaway keyboard we used 

during testing, this involved pressing the Ctrl+blue Fn+green Fn keys 

simultaneously.
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5. While you’re reading the manual, find out if the device has a default passkey. Mice 

almost certainly will (and it’s nearly always 0000), but keyboards might require you 

to type one manually when it comes to the pairing request.

6. Right-click the Bluetooth icon and select Preferences. In the Bluetooth Preferences 

dialog box, click the Services tab. Ensure there is a check alongside Input Service in 

the list, and then click the Input Services entry in the list so that it is selected. Click 

the Add button at the bottom of the dialog box.

7. You should find that your keyboard/or mouse is detected automatically and appears 

in the list below the Select Device heading (if not, ensure that it is still in discov-

erable mode, and hasn’t switched itself off ). Click the entry for the keyboard or 

mouse, and then click the Connect button.

8. A comment box should pop up on the Ubuntu computer, notifying you of a pairing 

request between Ubuntu and the keyboard or mouse (similar to Figure 8-12). Click 

the Enter Passkey button.

9. What happens next depends on whether you’re trying to connect a keyboard or 

mouse (bear in mind that the process of pairing quickly times out on the Ubuntu 

computer, so you need to complete the following steps without hesitation). 

• In the case of a mouse, enter the passkey that you read earlier in the manual for 

the mouse. As mentioned, this is usually 0000. Once you click OK, the mouse 

should be paired and should start working. 

• Some keyboards also use a default passkey of 0000, and, if so, you can enter 

that, and the keyboard should be paired. However, some Bluetooth keyboards 

might require you to enter a passkey created on the computer. In the 

Authentication Request dialog box on the Ubuntu PC, type a random four-digit 

passkey—something like 1234 (although for security reasons, you might want to 

choose something that’s slightly less easy to guess). Click OK. On the Bluetooth 

keyboard, type the same number and hit Enter. Following this, you should find 

the keyboard is paired with the computer and will work. 

10. Click Close in the Bluetooth Preferences dialog box. 

If you find the keyboard or mouse does not work after a reboot, try turning it on and off 

again. If that doesn’t work, deactivate the Bluetooth functionality on the PC, perhaps 

by momentarily unplugging the Bluetooth dongle or, on a notebook, using the relevant 

keyboard combination to turn off and on again the Bluetooth system. 
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Configuring Sound Cards
Generally speaking, your sound card shouldn’t require any additional configuration and 

should work immediately after you install Ubuntu. The icon for the volume control applet 

is located at the top right of the Ubuntu desktop, and it offers a quick way to control the 

master volume.

However, if your sound card offers more than stereo output, such as multiple-speaker 

surround sound, then it might be necessary to take some simple steps to allow full control 

of the hardware:

1. Right-click the volume control icon (the one that looks like a speaker), and select 

Open Volume Control. 

2. In the dialog box that appears, click Edit, and then click Preferences. 

3. The Volume Control Preferences dialog box appears, as shown in Figure 8-13. Select 

the sliders that you wish to be visible. For example, on a desktop computer that has 

5.1 surround sound, we were able to add a slider for the center and back speakers. 

On a notebook that has a sound card featuring pseudo-surround sound, we could 

add a control to alter the intensity of the effect.

Figure 8-13. You can add sliders to control all aspects of your sound card’s output.
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4. When you’ve finished, click the Close button. The new controls should then be 

visible in the Volume Control window. 

Configuring E-Mail and Instant Messaging
Being online is all about staying in touch, and Ubuntu is no slouch in this regard. Ubuntu 

offers a full-featured e-mail program, called Evolution, as well as an instant messaging 

client called Pidgin.

Unlike similar instant messaging clients, Pidgin supports a wide variety of Internet 

chat protocols, such as AIM/ICQ, MSN, Yahoo, Jabber, and IRC. This means you can chat 

with friends and colleagues on different networks using this one program. 

Evolution is able to work with both IMAP and the popular POP3 mail servers offered by 

ISPs and used within corporate environments. Additionally, it can work with the Microsoft 

Exchange protocol used by offices running the Outlook mail program and also Novell 

GroupWise. We’ll look at the specifics of using Evolution in Chapter 27. Here, you’ll learn 

how to configure the e-mail client to receive and send mail.

Configuring E-Mail Access

Before starting, you’ll need to find out the addresses of the mail servers you intend to use. 

In the case of POP3 and IMAP mail accounts, you’ll need to know the incoming and 

outgoing server addresses (outgoing may be referred to as SMTP). In the case of Microsoft 

Exchange, you’ll need to know the OWA URL and, optionally, the Active Directory/Global 

Address List server. With Novell GroupWare, you’ll simply need to know the server name. 

You’ll also need to know your username and password details for the incoming and 

possibly outgoing mail servers.

After gathering the necessary information, follow these steps to configure Evolution:

1. Start the Evolution e-mail client by clicking its icon at the top of the screen, to the 

right of the menus. Alternatively, you can select Applications ➤ Office ➤ Evolution 

Mail and Calendar.

2. When Evolution starts for the first time, you’ll be invited to enter your configu-

ration details via a wizard. Click the Forward button.

3. The next screen offers an option to restore Evolution settings from backup. This is 

a convenient option for migrating accounts from one Evolution client to another. 

Since this is your first time using Evolution, you can simply ignore this option by 

clicking the Forward button.



170 CH AP T E R  8  ■  G E T T I N G  E V E R Y T H IN G  U P  AN D  R U N N I N G

4. You are asked for your name and the e-mail address you wish to use within Evo-

lution. These are what will appear in outgoing messages. Beneath this is a check 

box that you should leave checked if you want the account you’re about to create to 

be the default account. In nearly all situations, this will be the correct choice. You 

can also fill in the Reply-To and Organization information if you wish, but these 

fields can be left blank. They’re not normally displayed by most e-mail clients. 

Click the Forward button to continue.

5. The next screen asks for details of the receiving (incoming) mail server that you 

want to use, as shown in Figure 8-14. First, select the server type from the drop- 

down list. If you don’t know which option to go with, select POP. This is by far the 

most common type of incoming mail server currently in use.

Figure 8-14. Evolution can work with a variety of mail servers, including POP3, 

Microsoft Exchange, and IMAP.
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6. Additional configuration fields will appear when you make the selection of server 

type. Enter the server address and username in the relevant fields. Click Check for 

Supported Types to find out what kind of authentication security, if any, your mail 

server uses. Following this, you should find the details are filled in automatically. 

Click Forward to continue.

7. You might need to enter your mail password, depending on which server type you 

chose. In some cases, you’ll need to type this later when you download your mail 

for the first time. Click Forward to continue.

8. You’re given the chance to choose between various additional options, such as how 

often you want Evolution to check for new mail or if you want to delete mail from 

the server after it has been downloaded. Unless you have been told otherwise or 

have special requirements, it should be okay to leave the default settings as they 

are. If you use a Microsoft Exchange server, you may need to enter the Active 

Directory/Global Address List server details here. Click Forward to continue.

9. Depending on the server type you chose, you might now need to fill in the outgoing 

(SMTP) server address. Type this into the Server field. If your SMTP server requires 

authentication, put a check in the relevant box, and then enter your username. 

Once again, you can click the Check for Supported Types button to automatically 

fill in the authentication details. Click Forward to continue.

10. You’re invited to enter a name for the account. This is the account name you will 

see when you use Evolution. The default is your e-mail address, but you can type 

something more memorable if you wish. Click Forward to continue.

11. Finally, choose your location, which will have the effect of automatically defining 

your time zone. This will ensure that e-mail messages are correctly time-stamped. 

You can choose your location from the Selection drop-down list (choose the nearest 

large city in your time zone), or click your location on the map. As during initial 

installation of Ubuntu, the map will zoom in when you click continents, to let you 

more precisely click the place you live. Click Forward to continue, and then click 

the Apply button to finish the wizard.

As noted earlier, Chapter 27 includes a full run-through of Evolution’s main functions. 

Setting Up Instant Messaging

Instant messaging is a way of chatting with other people in real time. It’s as if you were 

having a phone conversation, but you’re typing instead of speaking. You can talk to one 

other person or a whole group of people and sometimes share files with them.
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The instant messaging program under Ubuntu, Pidgin, offers the same functions and 

works in an almost identical way to programs that you might have used under Windows. 

It supports virtually all the popular chat standards, such as ICQ/AOL, Google Talk, Yahoo, 

and MSN (Hotmail/Passport). It assumes that you already have an account with each 

service, which will likely be the case if you’ve used instant messaging programs under 

Windows. You can have as many accounts as you wish and can select the one you want to 

use when you log in.

To transfer your instant messaging account over to Pidgin, you just need your screen 

name and password. As with other instant messaging clients, you’ll be able to choose an 

on-screen alias.

Follow these steps to set up Pidgin:

1. Start Pidgin by clicking Applications ➤ Internet ➤ Pidgin Internet Messenger. 

When the program starts for the first time, it will automatically open the Accounts 

dialog box, although it might be behind the main login window. If so, click to bring 

it to the front of the desktop.

2. In the Accounts dialog box, click the Add button and, in the window that appears, 

select the account type you want to set up from the Protocol drop-down list.

3. Enter your screen name, password, and alias details, as required.

4. If you don’t want to type your password each time you run Pidgin, check Remember 

Password. However, be aware that someone else using the computer could abuse 

your account.

5. You can put a check in the New Mail Notifications box if you want to be notified of 

any mail sent to you via the address registered with your instant messaging service.

6. If you want to use a buddy icon (the icon that others will see when they connect to 

you), click the Open button and browse to a picture.

7. If you wish to connect to a specific instant messaging server or if your network uses 

a proxy, click the Advanced tab and enter the details accordingly. In most cases, 

you won’t need to do this.

8. When you’ve finished, click the Save button. 

9. Pidgin will attempt to connect to the chat service. In the main Pidgin window, you 

should be able to see your chat contacts. Close the Accounts window.

After this, you should find the program works just like any other instant messaging 

program. You can double-click each contact in your list to start a conversation. To sign off, 

right-click the icon in the notification area, and then select the Change Status option from 
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the menu, as shown in Figure 8-15. To add another account, click Accounts ➤ Manage, 

click the Add button in the Accounts window, and then follow the preceding step-by-step 

instructions.

Figure 8-15. You can control Pidgin by right-clicking its notification area icon.

Summary
In this chapter, you learned how to set up just about every piece of hardware you might 

have attached to your computer. Additionally, we looked at configuring various software 

components that are vital for Ubuntu’s correct functioning.

We stepped through getting online with Ubuntu (including joining a wireless network), 

configuring e-mail, adding a printer, connecting to a digital camera, configuring a 3D 

graphics card, and much more.

In Chapter 9, we move on to look at how you can ensure that your system is secure 

and protected.


